
Using Bookshelf Dialog Boxes
Bookshelf has both dialog boxes and Tabbed Lists you can use to locate and work with 
information. To learn about the Tabbed Lists, click Using the Tabbed Lists to Locate 
Information.
The dialog boxes are accessible through commands on the Bookshelf menus. A command 
with an ellipsis indicates that it opens a dialog box. A few dialog boxes open when a button 
is clicked. 
For more information:

Print Dialog Box Description
Print Setup Dialog Box Description
Note Dialog Box Description
Advanced Find Dialog Box Description
Options Dialog Box Description
Flag and Country and State Information Dialog Box Description
Flag Browser Dialog Box Description
Task List Dialog Box Description
Copy Dialog Box Description

The following dialog boxes open if you have installed Bookshelf and Microsoft Word for 
Windows:

Copy to Word Dialog Box Description
Quote of the Day Dialog Box Description

The following dialog boxes give you options for using the Bookshelf QuickShelf feature with 
other Windows applications:

QuickShelf Customize Dialog Box Description
QuickShelf Keys Dialog Box Description

You can click dialog box options with the mouse to select them, or you can use the keyboard.
For more information:

Choosing Dialog Box Options with Keys



Print Dialog Box Description
The Print dialog box (choose Print Article on the File menu) is where you can select options 
before you print an article. If you want to print the whole article, just click the OK button. If 
available, you can select options such as Print Quality and Number of Copies (and Collate 
Copies).
Click the Setup button to change your printer settings.
Click the Cancel button, if you decide not to print. This closes the box and returns you to 
Bookshelf. You can also close the box by clicking the Control-menu box in the upper-left 
corner, and then clicking Close.
See Also
Print Setup Dialog Box Description
Choosing Dialog Box Options with Keys



Print Setup Dialog Box Description
The Print Setup box (click the Setup button in the Print dialog box) lets you change printer 
settings before printing. The appearance of this box will vary depending upon the printer 
that you're using. Some Print Setup dialog box options include:
    Default Printer: Lists the printer that Bookshelf will use unless you choose another from 

the Specific Printer list.
    Specific Printer list: Lists the installed printers. Click a name in the list to use that printer. 

If the printer you want is not in the list box, switch to the Windows Control Panel, select 
Printers, and activate the printer you want to use. Then switch back to Bookshelf.
    Orientation: Controls the direction in which text is printed on the page. Choose Portrait to 

print so that the page is taller than it is wide; choose Landscape to print so that the page is 
wider than it is tall.
    Paper Size list: Lists the sizes of paper you can choose from.
    Paper Source list: Lists the sources from which the printer can get its paper. There may be

an Options button in the dialog box; click it to display the Options dialog box where you can 
select options for the printer selected in the Printer list. The available options depend on the 
type of printer selected.
Click OK to save your changes after you've made your selections, and then click OK in the 
Print dialog box to close the boxes.
Click the Cancel button, if you decide not to select any options. This closes the box and 
returns you to the Print box. You can close the Print box by clicking Cancel, or by clicking the 
Control-menu box in the upper-left corner, and then clicking Close.
See Also
Print Dialog Box Description
Changing Printers and Printer Options
Choosing Dialog Box Options with Keys



Note Dialog Box Description
Use the Note dialog box (choose Note on the Edit menu) to add your own notes to an article 
and to keep a handy list of all the articles that interest you the most. You can use this 
personalized list to open the articles as well as read your notes on them. When you are 
finished using your notes and your list, you can delete items you no longer need.
Click the Add Current Article button to place the article you are reading on the list of Articles,
on the left. Notice that the article title appears at the top of the Articles list.
The Annotate box, on the right, is where you type your note. If you make a mistake, press 
the BACKSPACE key to erase any unwanted characters, and then continue typing. Text wraps 
automatically, but you can end a line before it wraps by pressing ENTER.
Click the OK button to save your note and close the Note box.
Click the Cancel button, if you decide not to add a note. This closes the box and returns you 
Bookshelf. You can also close the box    by clicking the Control-menu box in the upper-left 
corner, and then clicking Close.

 Notice when you add a note that a Note icon is added to the upper-right corner of the 
article. You can click this icon to read your note.
Click the Go To button to jump to any article on the Articles list. Just click an article title, and 
then click Go To.
Click the Delete button when you no longer need your notes. Just click an article title in the 
articles list, and then click Delete. When you click OK, this deletes the article title from the 
list, the note from the Annotation box, and the Note icon from the article.
See Also
Adding a Note to an Article
Copying and Pasting into a Note
Choosing Dialog Box Options with Keys



Advanced Find Dialog Box Description
The Advanced Find dialog box (choose Advanced Find on the Tools menu) operates just like 
the Find Tabbed List box. You can use either to perform a full-text search for a word, phrase, 
or number. But Advanced Find gives you more choices, so you can pinpoint your search. For 
example, you can narrow your search to one article. You can even choose to go back and 
search again in the articles you've already looked through. In addition, when you use 
Advanced Find you can pick as many books as you want to search through.
In the text box, type the word, phrase, or date you want to find. Click the down arrow next to
the text box to see a list of previous search requests. If you want to reuse one of them, just 
click a list item.
Click the Hints button to get some suggestions for narrowing the scope of your search.
For the "Select Where to Look" options there are three selections:

Click All Articles (the default) to search through all the articles in the selected books.
Click Current Article Only to limit your search to the article currently open in the 

Article Window.
Click Last Articles Found to limit your search to the articles in the list generated by 

your last search.
Click the buttons for the books you want to search in. All Books is the default. You can 
choose any combination of books.
Remember, if you selected the Current Article Only or the Last Articles Found options, make 
sure your book selections match your previous selections.
Click the Cancel button if you decide not to perform a full-text search. This closes the box. 
You can also close Advanced Find by clicking the Control-menu box in the upper-left corner, 
and then clicking Close.
Click Find! to start your search. Bookshelf looks through the article or articles you've 
selected to find your word, phrase, or date.
The list of all the articles Bookshelf finds appears in the Find Tabbed List Area. Use the 
vertical scroll bar to look through the list. Drag the mouse pointer slowly over the tiny book 
icons at the left of the list items. This pops up the name of the book that the article is from.
Click a list item to open an article. The list of articles found stays open so you can refer back 
to it and choose other articles to read.
If you'd like, you can click the close box in the upper-right corner of the Contents Tabbed List
to close it and make more room to read the article. Click any tab to reopen the Tabbed List 
Area.
See Also
Performing a Full-Text Search with Find
Find Hints: How to Narrow the Scope of a Find
Choosing Dialog Box Options with Keys



Options Dialog Box Description
The Options dialog box (choose Options on the Tools menu) is where you can make some 
adjustments to Bookshelf to suit your personal taste. Use the Options box to specify the 
colors you want for jump text and pop-up text. In addition, you can use this box to turn off 
both the incidental sounds that you hear when you open books and the names of the books 
that pop up when you move the mouse pointer over book icons and tools (these pop-up 
words are called ToolTips).    You can also change the NEAR search operator in this dialog 
box. 
The colored text at the top of the box is the Jump and Hotspot example text. When you 
change the colors of the text, these examples will change color too, and give you a preview 
of your choices.
To change the Jump Hotspot Color or the Pop-Up Hotspot Color, click the down arrow next to 
the text box to display a list of colors. Scroll through the list, and click the color you want. 
The default colors are Light Magenta for jump text and Light Green for pop-up text.
To turn off the following options click the X in the check box (to turn them back on, click the 
check box again):
 Interface Sounds--the whirring sounds you hear when you choose certain features of 

Bookshelf. 
 ToolTips--the pop-up names of icons and unlabeled buttons you see when you slowly move 

the mouse pointer over them.
 Normal Menus--this turns off the textured, colored background behind the Bookshelf menu 

bar. 
To change the NEAR seach operator from 50 to another number, click an insertion point to 
the right of the 50, BACKSPACE over it, and then type another number. Type a lower number to
search articles for words that are closer to each other than 50 words.
Click the OK button to save your changes, and close the Options dialog box.
Click the Cancel button, if you decide not to make any changes. This closes the box and 
returns you to Bookshelf. You can also close the box by clicking the Control-menu box in the 
upper-left corner, and then clicking Close.
See Also
Find Hints: How to Narrow the Scope of a Find
Choosing Dialog Box Options with Keys



Flags and Country and State Information Dialog Box 
Description
To open this box, click a flag in the atlas. In this box you may have several options 
available--including seeing the flag of the place on the current map, listening to an anthem, 
listening to the place name pronounced, opening an article in the almanac or the 
encyclopedia, or copying the flag. Click the close box in the upper-left corner of each box to 
close it. (You can also click outside the boxes to close them.)
The following options may be available in the Flags box:
Audio icon with the phonetic pronunciation next to it--Click to hear the place name 
pronounced.
Audio icon labeled National Anthem--Click to hear the national anthem of the country.
Encyclopedia icon--Click to open an encyclopedia article on the current place. When you're 
finished, click the close box in the upper-left corner.
Almanac icon--Click to open an almanac article on the current place. When you're finished, 
click the close box in the upper-left corner.
Copy Flag icon--Click to copy the flag onto the Clipboard. From there you can paste the flag 
into another Windows application.
See Also
About The Hammond Atlas
Choosing Dialog Box Options with Keys



Flag Browser Dialog Box Description
Use the Flag Browser (choose Flags on the Tools menu when the atlas is open) to look up 
flags of the countries of the world and the U.S. states. 
In the text box, type the name of the country or state whose flag you would like to see.The 
list will scroll to the name as you type. (You can also use the scroll bar to browse through the
list.) Click the name on the list to see the flag, or click the Show button.
To copy the flag you are looking at onto the Clipboard, click the Copy Flag button. Then you 
can paste the flag into another application.
To close the box, click the Close button. 
Click the Help button to display this topic.
See Also
About The Hammond Atlas
Choosing Options in Boxes



Task List Dialog Box Description
The Windows Task List box is where you switch quickly between open applications. Use this 
box when you move back and forth between applications using QuickShelf. The Task List also
has options for arranging windows and closing down tasks. You open the Task List box by 
clicking the Control-menu box in the upper-left corner of a window, and then clicking Switch 
To.

Select this option                                        To do this
Task list List the applications or tasks that are open. Double-click the 

application or task you want to switch to. Or click an application
or task you want to close, and then click the End Task button.

Switch To button Activate the window for the application or task selected in the 
task list.

End Task button Close the application or task selected in the task list.
Cancel button Cancel the command and closes the box.
Arrange Icons button Line up icons for open applications in a row at the bottom of the

screen.
Cascade button Resize and layer open group windows so that each title bar is 

visible.
Tile button Arrange and resize open windows side by side so that all are 

completely visible and occupy equal screen space.
See Also
Selecting Windows
Choosing Options in Dialog Boxes



Copy Dialog Box Description
The Copy dialog box is where you can copy text, pronunciations, or pictures onto the 
Clipboard so you can paste them into other applications or into Bookshelf's Note feature. 
This box appears when you click the Copy button. You can use the Copy button to copy the 
text of an entire article. If you want to copy a portion of an article, be sure to select the text 
before you click Copy.
The Copy dialog box gives you four options:
 Copy Selected Text. This option will be dimmed unless you select text before clicking Copy.
 Copy All Text. This is the default.
 Copy Picture. This will be dimmed if there is no picture that can be copied in the article.
 Copy Pronunciation. This will be dimmed if there is no pronunciation that can be copied in 

the article.
Click an option to select it. If you click an option that is already selected you will deselect it. 
Just click it again to select it. Click OK to activate your choice and close the box, or click 
Cancel to close the box without making any selections.
See Also
Infinite Links: Using the Right-Click Shortcut Menu
Choosing Dialog Box Options with Keys
Copying Text
Copying a Picture
Copying an Audio Clip or Pronunciation



Glossary of Error Messages
Error messages are listed below in alphabetic order by the first word in the message. Click a 
message to see a description of the cause and a suggested action. Click again to close the 
pop-up window. Use the scroll bar or press PAGE DOWN to view messages not visible in the 
window.
An error occurred while Bookshelf information was being pasted into Word. Please check 
your document.
An error occurred while loading Microsoft Bookshelf. Make sure that the Bookshelf CD-ROM 
disc is in the drive.
An invalid argument was passed to a search function.
An unknown error occurred.
A subexpression was used as an operand to the THRU operator. The THRU operator supports 
only simple terms as operands.
A subexpression within parenthesis begins or ends with an operator.
A word in the search query is too long. Search words can have a maximum of 255 
characters.
Bookshelf could not find WINWORD.EXE.
Bookshelf was unable to start Word.
Cannot read the Bookshelf Note file.
Could not open MCI device.
Could not open multimedia-controller window.
Could not open multimedia-element window.
Could not open multimedia window.
Could not open the document.
Could not write the Bookshelf Note file.
Error occurred attempting to open the specified multimedia device.
Filename extension of the specified multimedia file is not associated with any installed MCI 
devices.
Insufficient disk space to perform search. Delete some files to free disk space and try again.
Invalid value for NEAR. Enter a number from 1 to 999.
Multimedia controller failed due to an out-of-memory error.
Multimedia controller requires windows with multimedia.
No associated topics found.
No See Also articles found.
The operands to the THRU operator are of different data-types.
There is not enough memory to load this annotation.
There is not enough memory to complete the operation.
There is not enough memory to save this annotation.
The search failed.
The search failed. A disk-seek error occured.
The search failed. Bookshelf could not create a required file.
The search failed. Bookshelf could not open a required file because too many files are open.
The search failed due to a disk-read error.
The search failed due to an out-of-memory error.



The search query is too long or too complex.
The search failed.
The search failed. Bookshelf could not open a required file.
The search query contains an improper data value (for example, an invalid date or out-of-
range number),
The search query contains a word consisting of only a wildcard (*). Search words cannot 
begin with a wildcard, and the wildcard must be the last character in the word.
The search query has too many terms.
The search query is empty or has no searchable words. You cannot search for words marked 
as stop words (for example, "the," "that," or "a").
The search query is missing a left parenthesis mark.
The search query is missing a quotation mark.
The search query is missing a right parenthesis mark.
The search query is too complex. Do not nest parentheses more than five levels deep.
The search query or a subexpression within parentheses begins or ends with a search 
operator.
The word(s) [    ] could not be found in the Table of Contents.
This topic is too large to send.
This version of Bookshelf is incompatible with the multimedia controller.
Unable to search.
You cannot enter any more text in the annotation. The annotation cannot be more than 
30,000 characters in length.



You are trying to play an animation, a video, a demo, or an audio clip when there is not 
enough memory available, or there is a problem with Windows. If you are using other 
multimedia elements, close them to free memory, or save your work and close one or more 
applications, and then try again. If you still cannot play the animation, video, or audio close 
and restart Windows. If you still have problems, check your installation of Windows. To use 
all the features in Bookshelf, you need at least 2 megabytes of memory. If necessary, quit 
and restart Windows.



The topic (Bookshelf article) text is on the Clipboard. Try pasting it into Word.



You are trying to use the Find feature to do a full-text search in Bookshelf when there is not 
enough memory available. If you are using other multimedia elements, close them to free 
memory, then try again. If you still cannot use this feature, close one or more applications 
and try again. To use all of the features in Bookshelf, you need at least 2 megabytes of 
memory.



 You have used the asterisk wildcard character (*) incorrectly in your Find query. The asterisk
may be used only at the end of a word.



Bookshelf may not be installed properly. Try reinstalling.



You have used a subexpression within parentheses that either begins or ends with an 
operator (AND, OR NOT, NEAR), WHICH IS NOT ALLOWED. Or, you typed a word that is too 
common to search for. Type the Find request again, including specific words and making sure
that any subexpression within parentheses does not begin or end with an operator.



Please contact Microsoft Product Support, and give them the error code in your message.



Your Find query contains parentheses nested more than five levels deep. This is not allowed 
in Bookshelf. Revise your query and try again.



You are trying to play an animation, demo, or audio clip that is not compatible with any of 
the installed MCI devices. The appropriate files are identified by the filename 
extension, .mmm for an animation or a demo and .wav for an audio clip. Choose another 
animation, demo, or audio clip.



 Make sure WINWORD.EXE is in the directory specified by the Programdir option in the %s 
section of your %s file.    If necessary, reinstall Word and Bookshelf.



Check the Word document. If necessary, quit and restart Windows.



A new document window can't be opened in Word until you close other open document 
windows.



Try again. If necessary reinstall Word and Bookshelf.



You have selected a word in another application and used QuickShelf to look it up in 
Bookshelf, but the Table of Contents for the book you are looking in does not contain that 
word.



Check your CD-ROM drive to be sure you're using the Bookshelf disc. Make sure the disc is 
inserted properly. Click your disc and CD-ROM drive to be sure they are functioning properly.



Try setting up a different search query. For some suggestions on how to use search operators
see the following "Help topic--Find Hints: How to Narrow the Scope of a Find."



Your find query failed. Try closing one or more applications or features. Keep your query 
simple, type fewer words or operators in the text box. Avoid using very common words in 
your query.



Try setting up a different search query. Remember to keep it simple. THRU can be used to 
search for things like "aa THRU z" or "1 THRU 4", but not "aa THRU (dog and cat)".



Try setting up a different search query. Remember to keep it simple. THRU can be used to 
search for things like "aa THRU z" or "1 THRU 4", but not "aa THRU (dog and cat)".



You entered a NEAR value that was outside of the accepted range. Try again.



Your disk may be full, the temporary directory may have too many files, or the temporary 
directory may be on a read-only drive. Try restarting Windows.



The query failed because you have too many files open. Close one or more applications or 
features, then try again.



The Find feature cannot complete the query because of a disk error. Check the CD-ROM disc 
and your hard disk drive for errors.



Your Find query is too long. Type fewer words or operators in the text box, and then try 
again.



You either misspelled a word in your Find query, or typed a word too common to look for. 
Type a new query in the text box, including the specific words you want to find.



A Find query cannot begin or end with an operator (AND, OR, NOT, or NEAR). You did not 
type a word either before or after the operator, or you typed a word that is too common to 
search for. Try typing a specific word before or after the operator.



Your Find query is missing either an opening or a closing quotation mark. Add the quotation 
mark and try again.



Your Find query is missing    an opening parenthesis mark. Add the parenthesis mark and try 
again.



Your Find query is missing a closing parenthesis mark. Add the parenthesis mark and try 
again.



You have typed a word in your Find query that is too long to search for. Keep words in 
queries under 255 characters.



Check your search query to make sure the date or number you have typed is a proper value.



You are trying to start Bookshelf, but Bookshelf is having a problem finding the files. Either 
there is no CD-ROM disc in the drive, or your Bookshelf files are corrupt. Make sure that the 
Bookshelf CD-ROM disc is in the drive, and try again. If you still have a problem, run Setup 
again.



You are trying to play an animation, demo, or audio clip, but there is a problem with the 
respective driver in your Windows installation. In the Windows Main program group, double-
click the Control Panel icon, and then check the driver settings to make sure the device is 
correctly installed. Try closing and then restarting Windows. If you still have problems with 
the feature, check your installation of Windows.



You are trying to play an animation or audio clip, but Windows is not installed properly. 
Check your installation of Windows.



Your annotation is too long. Please shorten it, and try again. If you are copying text from a 
Bookshelf article into your annotation, try being more selective.



Your disk may be full. Some changes may not be reflected. Delete some files and try again.



Please close the Note dialog box and try again. If this does not work, try closing other 
applications to free up memory.



The file may be corrupt. Please cancel the Note dialog box.



Cancel the Note dialog box. Try closing other applications to free up memory.



 There is no list of related articles for this article.



You are trying to use the Find feature to do a full-text search in Bookshelf when there is not 
enough disk space available.



You are trying to play an animation or video, but there is no memory available, or there is a 
problem with Windows. If you are using other multimedia elements, close them to free 
memory, then try again. If you still cannot play the animation or video, close one or more 
applications or features and try again. If the problem continues, try closing and then 
restarting Windows. If you still have problems with the animation or video, check your 
installation of Windows.



The QuickShelf Toolbar Contents
QuickShelf is a floating Toolbar that consists of    several buttons you can click to look in the 
Bookshelf Tables of Contents or perform full-text searches using Bookshelf's Find feature. 
QuickShelf is located at the top of your other Windows applications, near the title bar. Move 
the mouse pointer slowly over the QuickShelf Toolbar to pop up the name of each button.
When you first install Bookshelf, QuickShelf consists of buttons for Encyclopedia Contents 
and for Dictionary Contents, plus the QuickShelf menu button at the far right. You can click 
the menu button to see choices for organizing QuickShelf to your own specifications. 
QuickShelf is designed to be customized to suit your needs. The first thing you'll probably 
want to do is add    buttons for the books you use most regularly, to increase QuickShelf's 
look-up power.
When you click the QuickShelf menu button on the right you will see the following 
commands: Customize, QuickShelf Keys, Help, About Microsoft QuickShelf, and Exit. Click a 
command to choose it.
 The Customize command opens the Customize dialog box, where you can add books and 

features to QuickShelf in the Toolbar Tab. Click the View Tab to change some of the settings 
in QuickShelf, such as the size of the buttons on the Toolbar.
 The QuickShelf Keys command opens the QuickShelf Keys dialog box, where you can create

custom key combinations to make using QuickShelf even faster.
 The Help command opens Help for QuickShelf.
 The About Microsoft QuickShelf gives you basic information about the product, including 

copyright information.

 Exit closes the QuickShelf Toolbar.

 A right-click on the QuickShelf Toolbar displays a shortcut menu. The Customize 
command is the same as the Customize command on the QuickShelf menu. A click on one of
the button commands changes the size of your QuickShelf buttons. The Minimize command 
reduces QuickShelf to an icon. The Help command displays QuickShelf Help.
For more information, click a topic:

Accessing Bookshelf from Other Applications Using QuickShelf
QuickShelf Customize Dialog Box Description
QuickShelf Keys Dialog Box Description



Accessing Bookshelf from Other Applications Using QuickShelf
You can click a button on the QuickShelf Toolbar while you are working in another Windows 
application (such as Microsoft Word for Windows) to look up words and phrases in any book 
in Bookshelf. 
For example, while writing a proposal in Word, you can use QuickShelf to look up a synonym 
for a word in the thesaurus.
 QuickShelf can either look up the word you want in the Table of Contents in a specified 

Bookshelf book or all of Bookshelf's books. 
 QuickShelf also can use the Find feature to perform a full-text search for the selected text 

within a specified book or all books.
A Floating Toolbar
QuickShelf is a floating Toolbar that appears near the title bar of your Windows applications. 
With QuickShelf, you highlight a word or phrase in another Windows application, and then 
click a QuickShelf button to look it up in Bookshelf. QuickShelf comes with buttons for 
looking up words and phrases in the dictionary and the encyclopedia--plus, you can add 
more buttons, so you can use Contents and Find to look in all the Books in Bookshelf, from 
any other application.
Always Available
When you set up Bookshelf, you also set up QuickShelf. Setup places the QuickShelf icon in 
your Startup Window in Windows Program Manager; this means that QuickShelf starts every 
time you start Windows on your computer. To change the location of the QuickShelf icon in 
Windows Program Manager, consult your Windows documentation.

 Familiarize yourself with QuickShelf by moving the mouse pointer slowly over it to pop 
up the names of the buttons.
To add buttons to the QuickShelf Toolbar:
1. Click the button at the far right of the Toolbar to display the QuickShelf menu.
2. Click the Customize Command.
3. In the Customize dialog box, click the Toolbar Tab, if necessary.

This is where you select the books you want to add to the Toolbar, and the feature--either 
Contents or Find--you want to use to look things up in them.

4. Click as many boxes as you want to add books and features. (Click an    X    to delete the 
book and feature, if you change your mind.)
Each click adds a button to the Toolbar. A button for a book using the Contents feature 
has a book icon. A button for a book using the Find feature has a book and magnifying 
glass icon.

5. Click OK to save your changes and close the box. (If you don't want to make changes at 
this time, click Cancel.)
Look at the QuickShelf Toolbar, you will see the new buttons.

 A right-click on the QuickShelf Toolbar displays a shortcut menu. The Customize command 
is the same as the Customize command on the QuickShelf menu. A click on one of the 
button commands changes the size of your QuickShelf buttons. The Minimize command 
reduces QuickShelf to an icon. The Help command displays QuickShelf Help.
To use the QuickShelf Toolbar:
1. In another Windows program, select a word or phrase.
2. Move the mouse pointer over the buttons on the QuickShelf Toolbar to locate the book you

want to look in and the feature you want to use.
3. Click a button on QuickShelf. If Bookshelf is not open, QuickShelf will open Bookshelf for 

you and look for your word or phrase.
If you click a Find button, you will see a message that lets you know Bookshelf is 



searching for your word or phrase.
4. Bookshelf opens to the book you were looking in. 
 If you used the Contents feature, the Contents Tab opens with your word or phrase in the 

text box and the article on your word or phrase displayed in the Article Window.
 If you used the Find feature, the Find Tab opens with your word or phrase in the text box, 

and the list of articles that contain your word or phrase in the list box. The first article on the
list is displayed in the Article Window.
5. In either Tabbed List box, click an item on the list to jump to a Bookshelf article.
6. To return to the other application, click the Control-menu box in the upper-left corner of 

Bookshelf, click Switch To, click the other application's name in the list, and then click the 
Switch To button.

To use key combinations:
1. In another Windows application, select the word or phrase you want to look up in 

Bookshelf.
2. Press the key combination that will use the Contents or the Find feature to look through a 

book or all Bookshelf books.
A key combination consists of two or more keys that you specify in the Key Combination 
Definitions box. For more information see "Setting Options for Key Combinations."
If Bookshelf is not open, QuickShelf will open Bookshelf for you and look for your word or 
phrase. 

    If you select more than one word, and then press a key combination that uses the Find 
feature, QuickShelf looks for the whole phrase, not for each separate word in the phrase. For
example, if you were looking for "a little something," QuickShelf would look for instances 
where the phrase "a little something" appears, not for instances of the separate words "a," 
"little," and "something."
3. Depending on whether you used a key combination with the Table of Contents or the Find 

feature the following will occur:
 If you used a key combination to look through a Bookshelf Table of Contents, the Contents 

Tabbed List box will appear, with article titles that match your word or phrase. (If there is no 
match, the Contents Tabbed List will appear with entries that come close to matching your 
word or phrase.) 
 If you used a key combination with the Find feature, the Find Tabbed List will appear with a 

list of all the articles that contain your word or phrase. (If no articles were found, a message 
will let you know.)
4. In either Tabbed List box, click an item on the list to jump to a Bookshelf article that 

contains your word or phrase.
5. To return to the other application, click the Control-menu box in the upper-left corner of 

Bookshelf, click Switch To, click the other application's name in the list, and then click the 
Switch To button.

See Also
QuickShelf Customize Dialog Box Description
QuickShelf Toolbar Contents
QuickShelf Keys Dialog Box Description



 The QuickShelf Customize Dialog Box Description
The Customize dialog box is where you tailor QuickShelf to your specific needs. You can 
customize the QuickShelf Toolbar to look things up in the books you use most. You can also 
choose to look things up using Contents or Find or both. In addition, you can reset QuickShelf
options to make the buttons larger, or turn off the ToolTip popups, or hide QuickShelf. 
The Customize dialog box consists of two tabs--the Toolbar Tab and the View Tab. The Toolbar
Tab is the default. It's where you add buttons to the Toolbar. Click the View Tab to change the
other QuickShelf settings, such as the size of the keys.
To customize the QuickShelf buttons on the Toolbar:
1. Click the button at the far right of the Toolbar to display the QuickShelf menu.
2. Click the Customize command.
3. In the Customize dialog box, click the Toolbar Tab, if necessary.

This is where you select the books you want to add to the Toolbar, and the feature--either 
Contents or Find--you want to use to look things up in them.

4. Click as many boxes as you want to add books and features. (Click an    X    to delete the 
book and feature, if you change your mind.)
Each click adds a button to the Toolbar. A button for a book using the Contents feature 
has a book icon. A button for a book using the Find feature has a magnifying glass and 
book icon.

5. Click OK to save your changes and close the box. (If you don't want to make changes at 
this time, click Cancel.)
Look at the QuickShelf Toolbar, you will see the new buttons.

To customize the look of QuickShelf:
1. Click the button at the far right of the Toolbar to display the QuickShelf menu.
2. Click the Customize command.
3. In the Customize dialog box, click the View Tab, if necessary.
4. Change the Toolbar Button Size by clicking one of the button options. A dot appears. (To 

remove the button option, just click the dot.)
5. To hide the Toolbar, click the X next to Toolbar is Always Visible. (To always have 

immediate access to the Toolbar, click the check box again. The X will appear.)
The Toolbar will not disappear if you click the X next to Toolbar is Always Visible, but it 
may get covered by other Windows applications as you use them. To see the QuickShelf 
Toolbar, hold down the ALT key and press TAB until it appears.

6. To turn off the ToolTips (the names that pop up as you move the mouse pointer over the 
buttons) click the X next to Show ToolTips. 
To show the ToolTips again, just click the check box again. The X will appear.

7. To save all your changes and close the box, click OK. (To close the box without making any
changes, click Cancel.)

 A right-click on the QuickShelf Toolbar displays a shortcut menu. The Customize command 
is the same as the Customize command on the QuickShelf menu. A click on one of the 
button commands changes the size of your QuickShelf buttons. The Minimize command 
reduces QuickShelf to an icon. The Help command displays QuickShelf Help.

See Also
Accessing Bookshelf from Other Applications with QuickShelf 



QuickShelf Keys Dialog Box Description
In the QuickShelf Keys box, you can set options for key combinations you use with 
QuickShelf. The books are listed on the left. (Note that All Books is on this list, which gives 
you the opportunity to create a key combination that will look in all books.) 
Text boxes for Contents or Find key combinations appear across from each book. Use the 
Contents edit boxes to create key combinations that look through the Table of Contents of a 
Bookshelf book from another windows application. Use the Find edit boxes to type key 
combinations that will have the Find feature look through specific Bookshelf books from 
another windows application.
 If you assign a QuickShelf key that is the same as a keyboard shortcut, such as CTRL+C (for 

copying) or CTRL+P (for printing), the QuickShelf key will override the keyboard shortcut.
For more information on using the key combinations that you set, see "Accessing Bookshelf 
from Other Applications Using QuickShelf."
To set options in the QuickShelf Keys dialog box:
1. Click the far right QuickShelf button, and from the QuickShelf menu, choose QuickShelf 

Keys.
The QuickShelf Keys dialog box opens.

2. Delete a key combination by moving the pointer to the Contents or Find text box that 
contains the combination you want to delete, clicking an insertion point, and then 
pressing the SPACEBAR.

3. Add a key combination by moving the pointer to the Contents or Find text box in which 
you want to add the combination, clicking an insertion point, and then simultaneously 
pressing the keys for the combination you want.
Generally, the keys you choose should have at least one modifier, such as SHIFT, ALT, or 
CTRL (the SHIFT or ALT key alone is not valid); see the default key combinations for 
examples. However, if you choose a key or a key combination that isn't valid because it 
doesn't have a valid modifier, Bookshelf will automatically add the CTRL key as a modifier. 
For example, if you press X, ctrl + x will appear in the text box. Or, if you press SHIFT + F2, 
CTRL + SHIFT +F2 will appear in the text box.

The following keys and key combinations cannot be used as valid key combinations:
    F1 and F10
    SHIFT or ALT alone in combination with another key
    CTRL+ALT+DEL
    CTRL+ALT+SHIFT+DEL
    ESC, PRINT SCREEN, PAUSE, ENTER, SPACEBAR, TAB
    The following characters: ( )    - + [ ] \ ; , /

4. Be sure there is an X in the Enable QuickShelf Keys check box in the lower-left corner. If 
there is no X, click the check box to enable it. (To disable QuickShelf Keys, click the X.)

5. Click Close to save your changes and close the dialog box.
See Also
Accessing Bookshelf from Other Applications with QuickShelf
QuickShelf Customize Dialog Box Description
QuickShelf Toolbar Contents



click
To press and release a mouse button once, usually the left mouse button.



full-text search
A search for a word or phrase through the entire text of every article in the open book, or in 
all books (depending on the search criteria you choose). When you use the Find Tab or the 
Advanced Find command on the Tools menu, you perform a full-text search. Doing a full-text 
search is different than looking in the Table of Contents, using the Contents Tab. When you 
use Contents, you look through the Contents List, not the entire text of articles.



icon
A miniature picture that represents something, such as a program in Windows Program 
Manager. Double-click an icon to open the program. Icons in the Program Manager Startup 
Window start automatically when you start Windows.
Icons also represent books and features on the QuickShelf Toolbar buttons. Click a button 
with a book icon to look up your word or phrase in that books Table of Contents. Click a 
button with an icon of a magnifying glass and book to use the Find feature to perform a full-
text search on your word or phrase.



jump
To move rapidly to another article. When you click hot text (or jump text) you jump to 
another article in Bookshelf.



pop-up 
When you move the mouse pointer over icons and unlabeled buttons you will pop up a label 
for the icon or button. This label is called a tooltip.



Program Manager
Your home base for using Windows and starting applications. When you start Windows, the 
Program Manager window is open on the desktop.



title bar
The horizontal bar at the top of a window that contains the title of the window. On many 
windows, the title bar also contains the Control-menu box and Maximize and Minimize 
buttons. Boxes also have title bars.



Bookshelf Word Integration Contents
When you install Bookshelf and Microsoft Word for Windows, you discover that the programs 
are integrated. You can enjoy the Bookshelf Quote of the Day whenever you start Word. And 
when you read Bookshelf you can copy articles, or portions of articles directly into Word.
For more information click:

Copy to Word Dialog Box Description
Quote of the Day Dialog Box Description



Copy to Word Dialog Box Description
The Copy to Word dialog box is where you can copy all or part of the text of a Bookshelf 
article to Microsoft Word for Windows in a single process. When you have installed both 
Bookshelf and Word, Bookshelf can copy your text and paste it into Word right where you 
want it. If you are currently running Word, all the open Word documents will be listed for you.
Bookshelf will paste the text into any Word document you select. If Word is not open, 
Bookshelf will open it for you and paste text from an article into a new document.
To copy text directly into Word:
1. Go to the article with the text you want to copy. If you want to copy only a portion of the 

article, select that text.
2. From the Edit menu, choose Copy to Word. Or press CTRL + W.
3. Make a selection from the Copy To list.
 New document. Click this if Word is not currently open, or if Word is open and you want to 

create a new document.
 Current location. Click this if you want to copy text into an open Word document right 

where you left the insertion point.
 End of [document name]. Click this if you want to add your text to the end of the named 

document.
4. Click Copy to copy and paste the text and close the box. Click Cancel if you decide not to 

copy. Click Help for information on the dialog box.
See Also
Choosing Dialog Box Options with Keys
Selecting and Editing in Text Boxes with Keys
Using the Buttons on the Article Window



Quote of the Day Dialog Box Description
When you have both Bookshelf and Microsoft Word for Windows installed, you can enjoy the 
Bookshelf Quote of the Day every time you start Word. This feature gives you a randomly 
chosen quotation each day.
Most of the quotations are short, but if the quotation is longer, click the down arrow on the 
scroll bar at the right to read the entire quotation. 
If you want to look at another quotation, just click the Another Quote button. You can read as
many quotations as you like this way.
If you want to use the quotation in your Word document, just click Paste Quote to paste it 
into Word. The pasted quotation includes a Bookshelf copyright citation. It is always 
important to cite your sources.
There is an X in the check box next to Display Quotation Daily. This means that you will 
always see the Quote of the Day when you start Word. If you do not want to see the Quote of
the Day, just click the X to turn off this feature. To turn it back on, click the check box again. 
Click Help to display the explanation you are reading. Click Close to close the dialog box.



Keyboard Shortcuts
You can perform most tasks in Bookshelf using either the mouse or the keyboard. 
For information on using Bookshelf with the keyboard, choose a topic:

Choosing Hot Text and Graphics with Keys
Choosing Menus, Commands, Tabs, and Buttons with Keys
Selecting Text with Keys
Selecting Windows with Keys
Resizing, Moving, and Closing Windows with Keys
Scrolling with Keys
Choosing Dialog Box Options with Keys
Selecting and Editing in Text Boxes with Keys
Copying and Pasting with Keys



Choosing Hot Text and Graphics with Keys
In Bookshelf, you can choose certain text and graphics that are hot to display additional 
information. You can choose text with a dotted underline to display a pop-up window 
containing a description, or you can choose text with a solid underline to jump to another 
article. You can also click certain graphics to get more information. The pointer changes to a 
hand when it is over hot text or graphics.
    You must have a mouse to play an audio recording or an animation in Bookshelf.

Use the following keys to choose hot text and graphics:
Press To
TAB Select hot text or graphics. Repeat to select the next hot item.
SHIFT + TAB Select hot text or graphics, moving in reverse order.
ENTER Open or close a pop-up box on hot text that has been tabbed to.
 You can select any word in the article window with the mouse pointer, and then press ENTER

to use the Infinite Links menu.



Choosing Menus, Commands, Tabs, and Buttons with Keys
The Article Window and the Tabbed Lists are accessible by pressing the TAB key. The Tab 
focus starts in the Article Window and moves to the Tabbed List Area.
SHIFT + TAB will always allow the user a way to back up at any point in the Tab order.
In the Article window, starting at the upper-left of the first screen, the user presses the Tab 
key to move from hotspot to hotspot in a left to right and down sequence. 
Use the following keys to choose a menu or command:
Press To
ALT + letter key Choose the menu whose underlined letter matches the one you type.
letter key Choose the menu item whose underlined letter matches the one you 

type (when a menu is open).
F1 Open Help.
LEFT or RIGHT ARROW Move among menus (when a menu is open).
UP or DOWN ARROW Move among commands (when a menu is open).
ENTER Choose the selected menu item.
ESC Cancel the selected menu.

You can choose a Tabbed List Tab using the keyboard:
Press To choose
CTRL + I Contents Tab
CTRL + F Find Tab
CTRL + G Gallery Tab
CTRL + B Back List Tab
You can choose a button using the keyboard:
Press To choose
CTRL + C Copy button
CTRL + P Print button
CTRL + Z Back button
CTRL + < <Page button
CTRL + > >Page button
ALT + N Next button
ALT + P Previous button
 If you assign a QuickShelf key that is the same as a keyboard shortcut, such as CTRL+C (for 

copying) or CTRL+P (for printing), the QuickShelf key will override the keyboard shortcut.

See Also
QuickShelf Keys Dialog Box Description
Choosing Dialog Box Options with Keys



Selecting Text with Keys
While you read an article, you can access Bookshelf information on any word right from the 
Article Window. When you first open an article, the article has the TAB focus. Use the arrow 
keys to go to the word you want to select. Select the word by holding down the SHIFT key and
pressing ENTER. The infinite links shortcut menu opens. Use this menu to look up a definition, 
copy a word onto the Clipboard, or perform a full-text search on your word in any book in 
Bookshelf.
To instantly see any word's dictionary definition using the infinite links menu:
1. Open the article, and use the arrow keys to go to the word you want to see defined.

Do not press TAB before you do this or you will lose the TAB focus. If you lose the TAB 
focus, simply reopen the article.

2. Hold down the SHIFT key and press ENTER to see the infinite links shortcut menu.
This menu contains several commands--you can look up the word's definition, or copy the 
current article, or use the Find In feature to do a full-text search. When the list first opens, 
Define is highlighted on the menu.

3. Press ENTER. 
A definition appears. This is the same definition that you would read in the dictionary.

4. When you are finished reading the definition, press ENTER to close the definition box.
To instantly copy a word onto the Clipboard using the infinite links menu:
1. Open the article, and use the arrow keys to go to the word you want to copy.
2. Hold down the SHIFT key and press ENTER to see the infinite links shortcut menu.
3. Use the down arrow key to go to Copy on the menu, and then press ENTER.

This copies the text onto the Clipboard.
4. In another application, or in Bookshelf's Note dialog box, press CTRL+ V.

This pastes the word into the other application or the Note.
To instantly copy text to Word:
1. If you have installed both Bookshelf and Word for Windows, you can use this feature.
2. Open the article, and use the arrow keys to go to the text you want to copy.
3. Hold down the SHIFT key and press ENTER to see the infinite links shortcut menu.
4. Use the down arrow key to go to Copy to Word on the menu, and then press ENTER.

The Copy to Word dialog box opens.
5. Use the down arrow key to go to the Help button. TAB to the Copy To list and then use the 

arrow keys to highlight an option on the Copy To list. Press ENTER to make the selection.
 New document. Press ENTER for this option, if Word is not currently open, or if Word is open, 

and you want to create a new document.
 Current location. Press ENTER for this option, if you want to copy text into an open Word 

document at the place where you left the insertion point.
 End of [document name]. Press ENTER for this option, if you want to add your text to the end

of the named document.
6. Use the down arrow key to go to the last list item. TAB to the buttons, and use the arrow 

keys to move among the buttons. Press ENTER at the Copy button to copy and paste the 
text and close the box. Press ENTER at the Cancel button, if you decide not to copy. Press 
ENTER at the Help button, for information on the dialog box.

To instantly do a full-text search using the infinite links menu:
1. Open the article, and use the arrow keys to go to the word you want to seach for.
2.    Hold down the SHIFT key and press ENTER to see the infinite links shortcut menu.
3. Use the down arrow key to go to Find In on the menu, and then press ENTER.

This activates a full-text search on your word in the book that you have chosen.
4. On the menu of books use the arrow keys to highlight any book title, or All Books, and 

then press ENTER.



5. The list of articles that contain your word appears in the Find Tabbed List Box. The first 
article on that list opens in the Article Window.
The word that you right-clicked on is highlighted in the article.

6. To look at other articles in the Find Tabbed List, just use the arrow keys to move up and 
down the list, and then press ENTER to open a specific article.

7. To return to the article you were reading when you opened the infinite links menu, press 
CTRL + Z.

See Also
Looking Up an Article
Getting a Definition from any Article in Bookshelf
Choosing Hot Text and Graphics
Performing a Full-Text Search with Find



Selecting Windows with Keys
Use the following keys to select the window you want to work in. This window becomes the 
active window. It appears on top of all other windows and its title bar is highlighted.
Press To
ALT + ESC Switch to the next application window or icon.
ALT + TAB Switch to the next application window, restoring applications that are 

running as icons.
CTRL + ESC Display the Task List dialog box.
ALT + F6 Switch back and forth between a dialog box and an article screen.



Resizing, Moving, and Closing Windows with Keys
Use the commands on the Control menu to resize, move, or close a window with the 
keyboard.
To resize, move, or close a window with the keyboard:
1. Select the window you want to resize, move, or close.
2. Press ALT + SPACEBAR to open the Control menu.
3. Press the underlined letter in the command name.
Choose To
Restore Restore a maximized window to its previous size, or make an icon a

window after it has been minimized.
Move Move the window. Use the arrow keys to move the window to the 

desired location, and press ENTER.
Size Customize the size of the window. Use the arrow keys to move the 

window borders to the desired size, and press ENTER.
Minimize Shrink the window to an icon.
Maximize Enlarge the window so that it takes up the full screen.
Close (or press ALT + F4) Close the window.
    You must restore a maximized window to its previous size before you can move it or 

customize its size.
See Also
Selecting Windows with Keys



Scrolling with Keys
Use the following keys to scroll through an article or list:
Press To scroll
UP ARROW or DOWN ARROW key                         Up or down one line in an article
UP ARROW or DOWN ARROW key Up or down one line in a Tabbed List
RIGHT ARROW or LEFT ARROW key                            Right or left in an article
PAGE UP or PAGE DOWN Up or down one window
CTRL + PAGE UP or CTRL + PAGE DOWN Left or right one window
HOME To the beginning of an article
END To the end of an article



Choosing Dialog Box Options with Keys
Use the following keys to move around in boxes:
Press To
TAB Move from option to option.
SHIFT+ TAB Move from option to option in reverse order.
ALT + underlined letter of label Move to an option or group.

Use the following keys to enter text in text boxes:
Press To
Arrow keys Move the insertion point left, right, up, or down.
SHIFT + Arrow key Select text.
BACKSPACE Delete the character to the left of the insertion point, or delete 

selected text.
DELETE Delete the character to the right of the insertion point, or delete

selected text.

Use the following keys to select option buttons and check boxes:
Press To
Arrow keys Select an option within a group of options.
SPACEBAR Select or clear a check box (add or remove an X).

Use the following keys to select an item from a list box or drop-down list box:
Press To
ALT + DOWN ARROW Open a drop-down list box.
Arrow keys Select an item in a list box.
HOME Move to the first item in a list box.
END Move to the last item in a list box.
PAGE UP or PAGE DOWN Scroll up or down in a list box, one window at a time.
ENTER Choose the selected item in the list box and carry out the 

command.

Use the following keys to choose command buttons:
Press To
ENTER Carry out the command of a selected button, or carry out the 

command of the default button (the button with the heaviest 
border).

ESC or ALT + F4 Close a box without completing the command (same as Cancel 
button).

See Also
Selecting and Editing in Text Boxes with Keys



Selecting and Editing in Text Boxes with Keys
Use the following keys to select and edit text in a text box:
Press To
Arrow keys Move the cursor left, right, up, or down.
HOME Move to the beginning of the line.
END Move to the end of the line.
CTRL + RIGHT or LEFT ARROW key Move the cursor right or left one word.
CTRL + HOME Move to the first character in a text box.
CTRL + END Move to the last character in a text box.
PAGE UP or PAGE DOWN Scroll up or down a window at a time.
SHIFT + Arrow key Select text.
SHIFT + movement key Extend the selection using any movement key, including 

arrow keys, HOME, END, CTRL + RIGHT/LEFTARROW, PAGE UP, PAGE 
DOWN, CTRL + HOME, CTRL + END.

BACKSPACE Delete the character to the left of the cursor, or delete 
selected text.

DELETE Delete the character to the right of the cursor, or delete 
selected text.



Copying and Pasting with Keys
Use the following keys to copy and paste information:
Press To
CTRL + C Copy selected portion of the displayed article onto the Clipboard.
CTRL + V Paste the contents of the Clipboard into the Bookshelf Note dialog box, 

or into another Windows application.

See Also
Adding a Note to an Article



Working with Windows
The following topics introduce the basic Windows skills you need to work with Bookshelf. For 
complete instructions on using Windows, see your Windows documentation.
For more information, choose a topic.

Selecting a Window
Resizing a Window
Moving a Window
Closing a Window
Using Scroll Bars
Choosing Options in Dialog Boxes



Selecting a Window
When you use Bookshelf, you may have several windows open at the same time. Commands
and actions affect the window that is selected. This window is the active window. It appears 
on top of all other windows and its title bar is highlighted.
To select a window using the mouse:

Click any part of the window except the Minimize and Maximize buttons.
The window is brought to the front, its title bar is highlighted, and its scroll bars and other 
elements become visible.

To select a window using the Task List:
1. Open the Task List box in one of these ways:
 Click the Control-menu box, and then choose the Switch To command.
 Double-click the Windows desktop.
 Press CTRL + ESC.

2. In the Task List dialog box, double-click the name of the window you want.
See Also
Selecting Windows with Keys
Task List Box Description



Resizing a Window
You can change the size of the windows open on your desktop in a variety of ways. You can 
minimize a window so that it appears on your desktop as an icon, or maximize a window to 
occupy the full screen. You can also make a window any size and shape you want.
To maximize a window so that it occupies the full screen:

Click the Maximize button in the upper-right corner of the window. The Maximize 
button has an up arrow.
To restore a maximized window to its previous size:

Click the Restore button in the upper-right corner of the window. The Restore button 
has a double arrow.
To minimize a window to an icon:

Click the Minimize button in the upper-right corner of the window. The Minimize 
button has a down arrow.
To restore an icon to a window:

Double-click the icon.
To customize the size of a window:
1. Point to a border or corner of the window.

The pointer changes to a two-headed arrow. If the window takes up the full screen, you 
must click the Restore button before you can change the windows size.

2. Drag the corner or border until the window is the size you want.
If you drag a border, the window size changes only on the side whose border you drag. If 
you drag a corner, the two adjoining sides move at the same time. An outline of the 
window border moves as you drag it.

3. Release the mouse button.
To cancel the resizing, press ESC before you release the mouse button.

See Also
Resizing, Moving, and Closing Windows with Keys



Moving a Window
You can move windows into any arrangement that suits your needs. For example, if the Help 
window is covering information in the Bookshelf window, you can move the Help window to 
the side.
To move a window:
1. Drag the title bar of the window to the new location.

An outline of the window moves as you move the mouse. If the window takes up the full 
screen, you must click the Restore button before you can move it.

2. Release the mouse button when the window is positioned where you want it.
To cancel the move, press ESC anytime before you release the mouse button.

See Also
Resizing, Moving, and Closing Windows with Keys



Closing a Window
When you finish working with a window, you can close it.
To close a window:

Double-click the Control-menu box in the upper-left corner of the window.
See Also
Resizing, Moving, and Closing Windows with Keys



Using Scroll Bars
Some windows and boxes have scroll bars you can use to view text that cannot fit in the 
space available.

To scroll Do this
Up or down one line Click one of the scroll arrows.
One window Click the scroll bar above or below the scroll box on vertical 

scroll bars, or to the left or right of the scroll box on 
horizontal scroll bars.

Continuously Point to one of the scroll arrows and hold down the mouse 
button until the information you want comes into view.

To any position Drag the scroll box to a position in the scroll bar that 
corresponds to the general location you want to be in the 
topic or list (beginning, middle, or end). For example, if you 
position the scroll box halfway down the vertical scroll bar, 
the text halfway through the topic or list appears.

See Also
Scrolling with Keys



Choosing Options in Boxes
Boxes contain the following types of options.

To use this option Do this
text box Point and click in a text box where you want to begin typing.

A flashing insertion point appears. Then type the text. You 
can delete characters by pressing the Backspace or Delete 
key.
Any text that is selected (highlighted) will be replaced by 
what you type. To select a single word in a text box, double-
click it. To select as many words or characters as you want, 
hold down the left mouse button while you drag the pointer 
across the text.

list box Click an item in a list box to select it. If necessary, use the 
scroll bar to see all the items in the list. If you want to select
an item and close the box at the same time, double-click the
item.

drop-down list box Click the arrow at the right of a drop-down list box to open 
it. To select an item, click the item. If necessary, use the 
scroll bar to see all the items in the list.

check box Click a check box to select or clear it.
option buttons Click an option button to select it.
command button Click a command button to choose it. If a command button 

is dimmed, it is not available at that time.
See Also
Choosing Box Options with Keys
Selecting and Editing in Text Boxes with Keys



 About The American Heritage Dictionary
The American Heritage Dictionary, third edition, has more than 350,000 entries and 
meanings, including brief biographies, geographic definitions, and pronunciations. In the 
dictionary, each word and its definitions is called an article. The dictionary articles are 
organized alphabetically. To see copyright information, open to the dictionary Contents 
screen and click the >Page button.
This edition of The American Heritage Dictionary includes 10,000 new words; enhanced 
usage, regional, and historical notes in the definitions; more synonym lists; and expanded 
illustrative uses. There are now over 2,000 images and 80,000 words pronounced in the 
dictionary.
Now, when you're reading an article in another Bookshelf book and you want to know a 
word's meaning fast, just highlight any word, then click it to pop up a definition from the 
dictionary.
In addition, the full power of the Bookshelf dictionary is now available from any application 
in Windows simply by clicking a button on the QuickShelf feature.
The Dictionary Article Window
When the dictionary opens you see its main window. The Article Window is the part of the 
main window where you read an individual dictionary definition, or article. Each article in the
dictionary consists of a single main word (the headword ) to be defined, followed by its 
definitions and, sometimes, by helpful notes about usage, regionalisms, and synonyms. If 
the headword has multiple meanings, the headword will be followed by a superscript 
number noting the meaning number (see, for example, the word "grave"). Each different 
meaning has its own dictionary article.
A    headword is accompanied by its phonetic pronunciation and part of speech. Click the 
phonetic pronunciation to see a pronunciation key. (You can click pronunciation symbols and 
words in the key to hear them spoken.) When you see an audio icon near the headword of an
article, you can click it to hear the word pronounced.
Highlighted words in the article are hot text and can be clicked to jump to other dictionary 
articles. You can see hot text in the explanatory notes at the end of definitions, too. When 
you click hot text in a note you will jump directly to the notes region of the other article.
Click the Back button at the bottom of the Article Window to go back to articles you've just 
looked through. 
In some articles in the dictionary, such as astronaut, piano, and weave, you'll find pictures 
that can be enlarged. You can click the picture to get a larger, more detailed view. Click 
again to close the enlarged image.
Locating Articles in the Dictionary
There are several ways to look for words in the dictionary: 
    The fastest way to use the dictionary from anywhere in Bookshelf is to double-click a 

word. The definition from the dictionary will pop up. To close, click the close box in the 
definition window's upper-left corner.
    Bookshelf can look for a word or phrase in the dictionary Table of Contents list. Just click 

the Dictionary icon in the Book Bar, then type the word or phrase you're looking for in the 
Contents Tabbed List (if it's closed, click the Contents Tab to open it), and then click an 
article title when it appears in the list to see the definition.
    Perform a full-text search on a word or phrase in the dictionary by clicking Dictionary icon 

in the Book Bar. Then click the Find Tab to open the Find Tabbed List box, type the word or 
phrase you're seeking, and then click the Find button. Bookshelf will find all the articles in 
the dictionary where your word or phrase appears. Click a list item to open the article.
    Click the Back List Tab to see a list of articles you've already looked at since you turned on

Bookshelf. Click an article title in the list to go back to it, if you want.
    After you've found an article, browse through nearby articles in either alphabetic or 



reverse alphabetic order by clicking the <Page or the >Pagebuttons at the bottom of the 
article window. You can also click the Previous or the Next buttons at the bottom of the 
Tabbed List Box to browse through articles in the current Tabbed List.
    When you are reading an article you can click a hot word or phrase to jump to a related 

article.
 Need a definition fast? You can right-mouse click any word in Bookshelf, and then choose 

Find In and Dictionary from the menus that appear, to perform a full-text search on that 
word in the dictionary.
To use QuickShelf to open the dictionary from another application:
1. In another Windows program, such as Word, highlight a word or phrase.
2. Move the mouse pointer over the buttons on the QuickShelf toolbar to pop up the titles of 

the dictionary buttons.
3.    Click the Dictionary Contents button on QuickShelf. If Bookshelf is not open, QuickShelf 

will open Bookshelf for you and look for your word or phrase.
Alternatively, you can click the QuickShelf Dictionary Find button. You will see a message 
that lets you know Bookshelf is searching for your word or phrase.
You may need to add dictionary buttons to the QuickShelf Toolbar. This is easy to do. See 
the cross-reference after Step 4.

4. Bookshelf opens the dictionary. 
 If you clicked the Dictionary Contents button, the Contents Tab opens with your word or 

phrase in the text box and the article on your word or phrase displayed in the Article 
Window.
 If you clicked the Dictionary Find button, the Find Tab opens with your word or phrase in the

text box, and the list of articles that contain your word or phrase in the list box. The first 
article on the list is displayed in the Article Window.
For more information on QuickShelf see:

Accessing Bookshelf from Other Applications Using QuickShelf

What's in the Dictionary Tabbed Lists
The Dictionary Contents Tabbed List
 The Dictionary Table of Contents lists all the articles in the dictionary. If Contents isn't open, 
just click the Contents Tab. Start to type the word or phrase you're looking for in the text box
at the top of the Contents list and watch as the list scrolls to your word. Click the article title 
in the list to open the article. Notice that the list items are marked with either a tiny arrow 
picon or a tiny book icon. The book icon indicates a single article, the picon indicates a 
general category that includes several articles. When you click a list item with an arrow 
picon, the first article in its sublist will appear.
The Dictionary Find Tabbed List
When you want to search through all the definitions in the dictionary that contain a certain 
word or phrase, use the Find Tab. Using Find is a handy way to add to the information you 
collect using the Table of Contents. Just click the Find Tab, type the word or phrase in the text
box, and then click the Find button. Bookshelf will give you a list of all the articles with the 
item you're looking for. Click a list item to see the article.    
The Dictionary Gallery Tabbed List
When you want to browse through all the multimedia items in the dictionary, click the 
Gallery Tab. In the Dictionary Gallery click the Picture button. The list of all the dictionary 
articles that have pictures appears. Use the scroll bar to browse through the list. Click a list 
item to open the article.
To close the Dictionary:
    Click another book icon on the Book Bar.
    Choose a different book from the Books menu.
    To close the dictionary and all of Bookshelf, too, click the Control-menu box in the upper-



left corner of the Bookshelf window, and then click Close.
See Also

Accessing Bookshelf From Other Applications Using QuickShelf
How the Main Window Works
How to Find Your Way Around Bookshelf



 About The People's Chronology
The People's Chronology is a social/historical compendium that begins at 3 million years B.C.
and ends in 1991. With information organized chronologically into 30 categories--from 
political events to nutrition, from crime to communications--this award-winning reference 
work is both an at-a-glance portrait of the world and a chronicle of the people and events 
that have shaped it.
The chronology is organized by year and subject. Each entry in the chronology is called an 
article. To see copyright information, open to the chronology Contents screen and click the 
>Page button.
You can now use the chronology from any application in Windows simply by clicking a button
on the QuickShelf feature.
The Chronology Article Window
When the chronology opens you see its main window. The Article Window is the part of the 
main window where you read about an individual historical event or circumstance in the 
chronology. Each article in the chronology consists of a heading with a subject-matter 
description, a date (for example, Food and Drink, 1601), and an informative paragraph. Click
the Back button at the bottom of the Article Window to go back to articles you've just looked
through. 
Locating Articles in the Chronology
There are several ways to look up historical information in the chronology. 
    Bookshelf can look for a word, phrase, or date in the chronology Table of Contents list. Just

click the Chronology icon in the Book Bar, then type the word, phrase, or date you're looking
for in the Contents Tabbed List (if it's closed, click the Contents Tab to open it), and then 
select an article title when it appears in the list.

 Start a full-text search on a word, phrase, or date in the chronology by clicking the 
Chronology icon in the Book Bar, and then clicking the Find Tab to open the Find Tabbed List 
box. Then type the word, phrase, or date you're seeking in the text box, and click the Find 
button. Bookshelf will find all the articles in the chronology where your word, phrase, or date
appears.
    Click the Back List Tab to see a list of articles you've already looked at since you turned on

Bookshelf. Click an article title in the list to go back to it, if you want.
After you've found an article, browse through nearby articles by clicking the <Page or

the >Page  buttons at the bottom of the Article Window. You can also click the Previous or 
the Next buttons at the bottom of the Tabbed List Box to browse through articles in the 
current Tabbed List.

 Need a historical fact in a hurry? You can right-mouse click any word in Bookshelf, and then
choose Find In and Chronology from the menus that appear, to perform a full-text search on 
that word in the chronology.
To use QuickShelf to open the chronology from another application:
1. In another Windows program, such as Word, highlight a word or phrase.
2. Move the mouse pointer over the buttons on the QuickShelf Toolbar to pop up the names 

of    the chronology buttons.
3. Click the Chronology Contents button on QuickShelf. If Bookshelf is not open, QuickShelf 

will open Bookshelf for you and look for your word, phrase, or date.
Alternatively, you can click the Chronology Find button. You will see a message that lets 
you know Bookshelf is searching for your word or phrase.
You may need to add chronology buttons to the QuickShelf Toolbar. This is easy to do. See 
the cross-reference after Step 4.

4. Bookshelf opens the chronology.
 If you clicked the Chronology Contents button, the Contents Tab opens with your word, 

phrase, or date in the text box and the article on your word or phrase displayed in the Article



Window.
 If you clicked the Chronology Find button, the Find Tab opens with your word, phrase, or 

date in the text box, and the list of articles that contain your word, phrase, or date in the list 
box. The first article on the list is displayed in the Article Window.
For more information on QuickShelf see:

Accessing Bookshelf from Other Applications Using QuickShelf

What's in the Chronology Tabbed Lists
The Chronology Contents Tabbed List
The Chronology Table of Contents lists all the articles in the chronology, by date and subject 
matter. If Contents isn't open, just click the Contents Tab. Start to type the word, phrase, or 
date in history you're looking for in the text box at the top of the Contents list, and then 
watch as the list scrolls to your word. Click the article title in the list to open the article. 
Notice that the list items are marked with either a tiny arrow picon or a tiny book icon. The 
book icon indicates a single article, the arrow picon indicates a general category that 
includes several articles. When you click a list item with an arrow picon, the first article in its
sublist will appear.
The Chronology Find Tabbed List
When you want to search through all the articles in the chronology that contain a certain 
word, phrase, or date, use the Find Tab. Using Find is a handy way to add to the information 
you collect using the Table of Contents. Just click the Find Tab, type the word, phrase, or date
in the text box, and then click the Find button. Bookshelf will give you a list of all the articles 
with the item you're looking for. Click a list item to see the article.    
The Chronology Gallery Tabbed List
When you want to browse through all the multimedia items in the chronology, click the 
Gallery Tab. In the chronology Gallery, click the Picture button or the Animation and Video 
button to see a list of all the articles that contain these multimedia items. Use the scroll bar 
to browse through the list. Click a list item to open the article.
To close the Chronology:
 Click another book icon on the Book Bar.
 Choose a different book from the Books menu.
 To close the chronology and all of Bookshelf, too, click the Control-menu box in the upper-

left corner of the Bookshelf window, and then click Close.
See Also

How the Main Window Works
How to Find Your Way Around Bookshelf
Using the Buttons on the Article Window



Glossary of Terms and Error Messages
For descriptions of Bookshelf terms or error messages, choose a topic:

Glossary of Bookshelf Terms
Glossary of Error Messages



Glossary of Bookshelf Terms
Bookshelf terms are listed below in alphabetic order. Click a term to see a description of the 
term. Click again to close the pop-up window. Use the scroll bar or PAGE DOWN to view terms 
not visible in the window.
Advanced Find
All Books screen 
animation/video button
arrow keys
article
article title
Article Window
audio icon
Audio button
audio controller
Back button
Back List Tab
Back List Tabbed List
Book Bar
book icon
Box
check box
click
Clipboard
command button
Contents screen
Contents Tab
Contents Tabbed List
Controller
Control menu
Control-menu box
Copyright information
cross-reference
default
demo
desktop
dialog box
dimmed
double-click
drag
drop-down list box
Find Tab
Full-text search
Gallery Tab
Help menu
hot



icon
infinite links
installed printers
jump
jump text
list box
Locator button
main window
maximize
Maximize button
media button
menu bar
minimize
Minimize button
mouse pointer
multimedia controller
Multimedia group window
NEAR
Next button
Note command
Note dialog box
option buttons
<Page button
>Page button
picon
picture icon
pointer
pop-up text
pop-up window
Previous button
Program Manager
QuickShelf
Restore button
right-click
scroll arrow
scroll bar
scroll box
See Also button
short cut menu
stop-word list
Tabbed List
text box
title bar
Tools menu
Topography Button



Window



Advanced Find
The command on the Tools menu that you use instead of the Find Tab when you want to 
precisely focus your search for a specific word, phrase, or date. Like the Find Tab, you use 
Advanced Find to perform a full-text search in any or all of Bookshelf books. You simply 
specify the word or phrase you're looking for, and Bookshelf generates a list of all the 
articles in which your word or phrase appears.
However, with Advanced Find you can narrow your search to one article. You can even 
choose to go back and search again in the articles you've already looked through. In 
addition, when you use Advanced Find you can pick as many books as you want to search 
through.



All Books screen
Shows all the books in Bookshelf. This is Bookshelf's opening screen--it also appears when 
you click the All Books icon in the Book Bar. 



Animation & Video button
In the Gallery Tabbed List, click this button to see a list of all the Bookshelf articles in the 
open book with animation or video.



arrow keys
Keys you can use to control the movement of the insertion point on the screen. Some 
keyboards have two sets of arrow keys: one on the numeric keypad and another set to the 
left of that area. If you use the arrow keys on the numeric keypad, be sure to turn NUMLOCK 
off.



article
A single entry in a book. An article might be a quotation, the definition of a word, a map in 
the atlas, a topic in the encyclopedia, or an entry in the chronology, thesaurus, or world 
almanac.



article title
An Item in a Tabbed List. Click an article title to open the article.
An article title in the Tables of Contents is used to look up articles in a book. Bookshelf's 
Tables of Contents contain the following types of article titles:
Book Contents entries
Dictionary Defined words, biographical names, and geographic locations.
Quotations Subjects of quotations, the names of all authors quoted (by first and 

last name), and some book titles.
Encyclopedia Titles of all encyclopedia topics.
Atlas Names of continents, countries, some regions, U.S. states, and most 

major cities.
Thesaurus Words for which there are synonyms.
Almanac Main subjects treated in almanac articles.
Chronology Dates and main subjects treated in chronology articles.



Article Window
The Bookshelf window where you read an article in a book. The article window is always 
open to the right of the Tabbed List Area. When you click an item in a tabbed list, the article 
opens in the Article Window. While you're reading an article you can always see the book 
icons in the Book Bar, so you can keep track of your place in Bookshelf, and you can choose 
other books to read.



Audio button
In the Gallery Tabbed List box, click this media button to see a list of all the articles in the 
open book that have audio clips.



audio icon
Click this icon to hear a pronunciation, a musical example, or a recorded quotation.



audio controller
The portion of the multimedia controller that is used to play a recording in the quotation 
book.



Back button
Displays the last article you viewed. Use this button to move back through articles you 
previously viewed.



Back List Tabbed list
A list of up to 40 Bookshelf articles you have viewed with the most recent article listed first. 
You can click an article on the list to display it again. You can open the Back List by clicking 
the Back List Tab or by choosing the Back List command on the Tools menu.



Back List Tab
Click the Back List Tab to display a list of the last 40 Bookshelf articles you have viewed, with
the most recent article listed first. You can click an article name on the list to jump to it. The 
Back List Tab can also be opened by choosing the Back List command on the Tools menu or 
by pressing CTRL + B.



Book Bar
A convenient shelf of seven book icons, plus the All Books icon, across the top of Bookshelf. 
Click an icon to open a book. Notice that the icon changes to an open book icon--this way 
you always can check and see which book you have open. When you move the mouse 
pointer slowly over the book icons without clicking, you can pop up the name of each book.



Book icon
A miniature representation of a Bookshelf book. Book icons are located on the Book Bar that 
runs across the top of Bookshelf. Click a book icon to open a book. It changes to an open 
book icon. 
The very small book icons that you see next to article titles in Tabbed Lists let you know 
which book the article is in.



check box 
A box that indicates an option you click to switch on and off. You can click as many check 
boxes as you want. When you click to select a check box, it contains an X. When you click 
again, the X is cleared and the option is no longer selected.



click
To press and release a mouse button once, usually the left mouse button.



Clipboard
The Microsoft Windows application that holds cut or copied information, which you can then 
insert into another file. Whenever you use a Cut, Copy, or Paste command, you are using the
Clipboard.



command button
A button that carries out or cancels an action in a box. One command button carries out the 
task and closes the box. This is usually named the OK button. The Cancel button cancels the 
task associated with the box. Other command buttons may offer additional options.



Contents Tab
Click to display the Contents Tabbed List box. Use this box to look up a word or phrase in the
Table of Contents for the open book. The Contents Tab is the same as the Contents 
command on the Tools menu and the CTRL + I keyboard shortcut.



Contents Tabbed List
Displays the Table of Contents for the open book. Type a word or phrase in the text box at 
the top to look it up in the Table of Contents. The list will scroll toward your word as you 
type. Click an article title on the list to open the article.



Contents screen
Appears when you first open a book. From here, you can use the Tabbed Lists to locate 
information in the book. To display the book's copyright information, click the >Page button.



Control menu
The menu in the upper-left corner of a window's or a box's title bar, indicated by a SPACEBAR 
icon. This menu contains commands for resizing, moving, and closing windows with the 
keyboard, and the Switch To command, which displays a list of all open windows.



Control-menu box
You can double-click this box to close the window, or click it once to display the Control 
menu, and then click Close.



copyright information
You can find copyright information by clicking the >Page button at the bottom of each book's
Contents screen (this is the first screen you see when you open a book). Copyright 
information for all of Bookshelf is available by clicking >Page on the All Books screen or the 
Copyright Information command on the Help menu.



cross-reference
Click a cross-reference to jump to the article it names. Cross-references appear as colored 
text with a solid underline.



default
A choice the program already has made for you. The default is usually the most common 
way to perform a function. You can change the default setting, if you want.



demo
The animated introduction to the key features of Bookshelf.



desktop
The background of your screen when Microsoft Windows is running. Windows, icons, and 
boxes appear on the desktop.



dialog box
Dialog boxes appear when you choose commands with ellipses (...) from menus (for 
example, the Advanced Find command on the Tools menu). When you right-mouse click on a 
word, you will see a list of commands, those with ellipses have dialog boxes that you can 
use. Most dialog boxes have options for you to select so that the program can carry out your 
commands with precision. Some dialog boxes have a Help button you can click for 
information about the box.



dimmed
When the letters on a button are "grayed out," this means the feature is not available.



double-click
To click an object twice in rapid succession, usually with the left mouse button. A double-
click on a word lets you see a definition from Bookshelf's dictionary.



drag
To hold down the left mouse button while you move the mouse to affect something on the 
screen. For example, dragging is used to select text and to move or resize windows and 
boxes.



drop-down list box
A list box that opens and closes in a dialog box.



Find Tab
Click to display the Find Tabbed List box. Use this box to search for a word or phrase in any 
combination of books. The Find Tab is the same as the Find command on the Tools menu or 
the CTRL + F keyboard shortcut.



full-text search
A search for a word or phrase through the entire text of every article in the open book, or in 
all books (depending on the search criteria you choose). When you use the Find Tab or the 
Advanced Find command on the Tools menu, you perform a full-text search. Doing a full-text 
search is different than looking in the Table of Contents, using the Contents Tab. When you 
use Contents, you look through the Contents List, not the entire text of articles.



Gallery Tab
Click to display the Gallery Tabbed List box. Use this box to look up media elements such as 
animations, video clips, audio clips, and pictures in any combination of books. The Gallery 
Tab is the same as the Gallery command on the Tools menu or the CTRL + G keyboard 
shortcut.



Help menu
Opens the Bookshelf Help Contents screen. Click a Help topic to find information about 
Bookshelf. Click Using Help to learn how to use Help. (You can also use the Help menu to 
open Help.)



hot
A colored word or phrase with an underline is "hot." You can click it to display a pop-up 
definition or explanation. A colored word or phrase of a different color with a solid underline 
is also hot. You can click it to jump to another part of the program. Some graphics are hot, 
too. Click a hot graphic to display information. When the mouse pointer is over hot text or 
graphics it changes into a hand.



icon
A miniature picture that represents something, such as a Bookshelf book. Click a book icon 
in the Book Bar to open a book. Icons also represent Windows applications or files. You can 
click audio icons to hear audio clips, such as pronunciations or musical examples.



Infinite Links
The menu you see when you right-click on a word in an article. Using this menu you can 
access Bookshelf information on any word right from the Article Window. By clicking items on
this menu, you can look up a definition (the same definition you'd see if you were using the 
dictionary), copy a word onto the Clipboard, or perform a full-text search on your word in any
book in Bookshelf.



installed printers
Printers that have been identified to Windows using the Windows Control Panel.



jump
To move rapidly to another article. When you click hot text (or jump text) you jump to 
another article in Bookshelf.



jump text
Colored text with an underline that you can click to go to another article.



list box
Lists items that you can choose from. If all the items cannot be displayed in the box, a 
vertical scroll bar appears.



Locator button
In the atlas, click this button to pop up a Location Map associated with the region you are 
viewing.



main window
The main window consists of the Book Bar, the Menu Bar, the Tabbed List Area, and the 
Article Window. Bookshelf is arranged so you can use these areas together easily when 
looking things up. Because you can always see these main areas, you can perform the most 
common activities--looking things up, browsing search results, and changing books--without 
any complex navigation.
Make using Bookshelf easier by taking some time to explore the way the parts of the main 
window work:
 The Book Bar, across the top of the Article Window, is where you choose a book and keep 

track of the open book.
 The Menu Bar, at the top left, is where you can choose a book or perform different 

functions with the text, such as adding a note, copying, using Advanced Find, or getting 
Help!
 The Tabbed Lists Area, to the left, is where you look for information, using one of 

Bookshelf's four convenient "look up" tabs: Contents, Find, Gallery, and Back List.
 The Article Window, to the right, is where you read an article in the open book. This is 

where definitions, quotations, thesaurus synonyms, encyclopedia entries, atlas maps, 
almanac lists, and chronology topics appear.



maximize
To enlarge a window to its maximum size by clicking the Maximize button in the upper-right 
corner of the window, or by choosing the Maximize command from the Control menu.



Maximize button
Enlarges a window to take up the full screen.



media button
In the Gallery Tabbed List box, you click a media button to see a list of all the articles in the 
open book that contain that media type. The media buttons are All Media, Animations and 
Videos, Audio, and Pictures.



menu bar
The part of the main window, located at the upper-left of Bookshelf, that contains commands
to help you use Bookshelf.
These commands can be used to open a book; print an article; copy an article, a picture, or a
sound; set options; write a note in a book; perform a focused full-text search; switch to a 
different book; or open Help.



minimize
To reduce a window to an icon by clicking the Minimize button in the upper-right corner of 
the window, or by choosing the Minimize command from the Control menu.



Minimize button
The Minimize button reduces a window to an icon.



multimedia controller
Any controller that is used to play multimedia elements in Bookshelf.



Multimedia group window
The window in Program Manager that contains the Bookshelf icon.



NEAR
NEAR is a word you use to make your search more precise. (This is what is known as a 
search operator.) When you use the Find Tab to perform a full-text search on a word or 
phrase, and you use the word NEAR (as in, for example, bees NEAR honey), Bookshelf 
searches in each article for all occurrences of the word "bee" within 50 words of the word 
"honey." You can change 50 to some other number in the Options dialog box.



Next button
The button at the bottom of the Tabbed List Area that you click to open the next article in 
the list (the article below the currently highlighted article).



Note command
This command opens the Note dialog box, where you can add your own note to an article. 
You can also keep a list of articles that interest you in the Note dialog box and use the list to 
go back to the articles. You can also press CTRL + N to open the Note dialog box.



Note Dialog Box
This is where you can add your own note to an article. You can keep a list of articles that 
interest you in the Note dialog box and use the list to go back to the articles. You can also 
press CTRL + N to open the Note dialog box.



Option buttons 
Can be selected one at a time in dialog boxes. The selected option button contains a black 
dot.



 <Page button
Displays the previous topic in the open book according to its browse order. (You can also 
press CTRL + <.) Each book has its own organization for browsing. The browse order for the 
encyclopedia and dictionary is alphabetic by article. The quotation book's browse order is 
alphabetic by subject matter and then alphabetic by author within each subject; the 
almanac's order is hierarchical by topic. The thesaurus browse order is by classes of subject 
matter.



>Page button
Displays the next topic in the open book according to its browse order. (You can also press 
CTRL+>.) Each book has its own organization for browsing. The browse order for the 
encyclopedia and    dictionary is alphabetic by article. The quotation book's browse order is 
alphabetic by subject matter and then alphabetic by author within each subject; the 
almanac's order is hierarchical by topic. The thesaurus browse order is by classes of subject 
matter.



picon
A tiny arrow-button icon found to the left of some list items in the Tabbed Lists. An arrow 
icon picon indicates a general list item. Click this general list item to see a list of related 
article titles.



picture icon
Some pictures in the dictionary and the encyclopedia are too large to fit on the same screen 
with the text, so they are reduced. Click the reduced picture to display a pop-up box showing
the picture at its full size.



pointer or mouse pointer
The cursor shaped like an arrow that normally appears on your screen. To work with objects 
on the screen, move this pointer over a screen object or text and then click the left-mouse 
button. The pointer turns into a hand when it moves over hot text or a hot screen object.



pop-up text
Colored, underlined text that you can click to display more information in a pop-up box. Pop-
up text is distinguished from jump text by its color. For more information, choose the Options
command on the Tools menu.



pop-up box (or window) and pop up (the verb)
When you click hot text of a certain color you pop up a box that supplies you with a 
definition. (See the Options command on the Tools menu for more information about pop-up 
color.)
This definition is in a pop-up box. Click again to close a pop-up box.
When you move the mouse pointer over icons and unlabeled buttons you will pop up a label 
for the icon or button. This label is called a ToolTip.



Previous button
The button at the bottom of the Tabbed List Area you can click to open the previous article in
the list (the article above the currently highlighted article).



Program Manager
Your home base for using Windows and starting applications. When you start Windows, the 
Program Manager window is open on the desktop.



QuickShelf
The new way to look things up in Bookshelf from any program in Windows. QuickShelf is a 
floating Toolbar that you can use while you're working with other applications.    Highlight a 
word or phrase in the other application, click a button on the QuickShelf Toolbar, and 
Bookshelf looks up your word or phrase for you.



Restore button
Replaces the Maximize button in the upper-right corner of a window that has been 
maximized to its full size. Click this button to restore the window to its previous size.



Restore button
Replaces the Maximize button in the upper-right corner of a window that has been 
maximized to its full size. Click this button to restore the window to its previous size.



Right click
Using the right mouse button, to press down and release the button. A right click on a word 
displays the Infinite Links menu, where you can look up a definition (the same definition 
you'd see if you were using the dictionary), copy a word onto the Clipboard, or perform a 
full-text search on your word in any book in Bookshelf.



scroll arrow
An arrow on either end of a scroll bar. Clicking a scroll arrow brings another line into view. 
Pointing to a scroll arrow and holding down the left mouse button scrolls through the 
contents of a window or list box continuously.



scroll bar
A bar that appears at the right edge of a list box or at the right or bottom edge of a window 
whose contents aren't completely visible. Each scroll bar contains two scroll arrows and a 
scroll box, which allow you to move the contents of the list box or window with the mouse.

To scroll Do this
Up or down one line Click one of the scroll arrows.
One window Click the scroll bar above or below the scroll box on vertical scroll bars, 

or to the left or right of the scroll box on horizontal scroll bars.
Continuously Point to one of the scroll arrows and hold down the mouse button until 

the information you want comes into view.
To any position Drag the scroll box to a position in the scroll bar that corresponds to 

the general location you want to be in the topic or list (beginning, 
middle, or end). For example, if you position the scroll box halfway 
down the vertical scroll bar, the text halfway through the topic or list 
appears.



scroll box
The rectangular box within a scroll bar that indicates your relative position within a topic or 
list box. You can drag the scroll box up or down to quickly scroll through a long topic or list.



See Also button
This button appears at the bottom of the article window in the encyclopedia and thesaurus. 
Click it to see a list of related articles. Click any article on the list to open it. To close the See 
Also dialog box, click the close button in 



short cut menu
The infinite links menu that appears when you right-mouse click on a word in Bookshelf.



stop-word list
The list of words that Bookshelf will not search for. These words appear so often within the 
books that searching for them would result in a useless list of topics found. The words in the 
stop-word list are:

1, 2, 3, a, an, and, as, at, be, but, by, do, for, from, have, he, in, it, not, of, on, 
or, she, that, the, there, they, this, to, we, which, with, you



Tabbed List
Any one of four lists that help you look up information in Bookshelf. The Tabbed Lists are 
located to the left of the article window. To open a Tabbed List click one of these tabs: 
Contents, Find, Gallery, or Back List.



text box
A box in which you can type or edit text.



title bar
The horizontal bar at the top of a window that contains the title of the window. On many 
windows, the title bar also contains the Control-menu box and Maximize and Minimize 
buttons. Boxes also have title bars.



Tools menu
The menu on the Menu bar that you use to as an alternative way to open the Tabbed Lists, 
or to perform an advanced full-text search, or to change Bookshelf settings.



Topography button
In the atlas, click this button under the article window to pop up a topographic map of the 
region you are currently viewing.



Window
The rectangular area on your screen in which you view an application or a file. You can have 
several windows open at one time and arrange them to suit your needs. You can move them 
and resize them, and you can view more than one window at a time.



 About The Concise Columbia Encyclopedia
The Concise Columbia Encyclopedia puts a world of knowledge at your fingertips with over 
15,000 short entries on a wide range of subjects. Plus, the encyclopedia has many 
animations and audio musical examples, as well as more than 1,300 pictures. Each entry in 
the encyclopedia is called an article. The encyclopedia is organized alphabetically. To see 
copyright information, open to the encyclopedia Contents screen and click the >Page 
button.
Now you can take advantage of this powerful encyclopedia from any application in Windows 
simply by clicking a button on the QuickShelf feature.
The Encyclopedia Article Window
When the encyclopedia opens you see its main window. The Article Window is the part of the
main window where you read an encyclopedia article. The title, or the headword, is at the 
top of the article. Sometimes a headword is accompanied by its phonetic pronunciation. 
Click the phonetic pronunciation to see a pronunciation key (and hear standard 
pronunciations). When you see an audio icon next to a word in an article title, you can click it
to hear the word pronounced. Look for musical example audio icons you can click, too.
Highlighted words in the article are hot text and can be clicked to jump to other 
encyclopedia articles.
In some articles in the encyclopedia, such as Hank Aaron, Oregon, and peony, you'll find 
images that can be enlarged. A caption explains that you can click the image to get a larger,
more detailed view. Click again to close the enlarged image.
You can click the See Also button at the bottom of the encyclopedia Article Window to 
browse through a list of related articles. (The See Also button is the same as the See Also 
command on the Tools menu.) Just click a list item to jump to the article. If a related-article 
list is not available, this button is dimmed. Click the Back button to go back to articles 
you've just looked through. 
Locating Articles in the Encyclopedia
There are several ways to look for information in the encyclopedia. 
    Bookshelf can look for a word or phrase in the Encyclopedia Table of Contents list. Just 

click the Encyclopedia icon in the Book Bar, then type the word or phrase you're looking for 
in the Contents Tabbed List (if it's closed, click the Contents Tab to open it), and then select 
an article title when it appears in the list.
    Start a full-text search on a word or phrase in the encyclopedia by clicking the 

Encyclopedia icon in the Book Bar, and then clicking the Find Tab to open the Find Tabbed 
List box. Then type the word or phrase you're seeking in the text box, and click the Find 
button. Bookshelf will find all the articles in the encyclopedia where your word, phrase, or 
date appears.
    Click the Back List Tab to see a list of articles you've already looked at since you turned on

Bookshelf. Click an article title in the list to go back to it, if you want.
    After you've found an article, browse through nearby articles in either alphabetic or 

reverse alphabetic order by clicking the <Page or the >Page buttons at the bottom of the 
article window. You can also click the Previous or the Next buttons at the bottom of the 
Tabbed List Box to browse through articles in the current Tabbed List.
    When you are reading an article you can click a hot word or phrase to jump to a related 

topic.
 You can right-mouse click any word in Bookshelf, and then choose Find In and Encyclopedia

from the menus that appear, to perform a full-text search on that word in the encyclopedia.
To use QuickShelf to open the encyclopedia from another application:
1. In another Windows program, such as Word, highlight a word or phrase.
2. Move the mouse pointer over the buttons on the QuickShelf toolbar to pop up the names 

of    the encyclopedia buttons.
3. Click the Encyclopedia Contents button on QuickShelf. If Bookshelf is not open, QuickShelf



will open Bookshelf for you and look for your word or phrase.
Alternatively, you can click the Encyclopedia Find button. You will see a message that lets 
you know Bookshelf is searching for your word or phrase.
You may need to add encyclopedia buttons to the QuickShelf Toolbar. This is easy to do. 
See the cross-reference after Step 4.

4. Bookshelf opens the encyclopedia.
 If you clicked the Encyclopedia Contents button, the Contents Tab opens with your word or 

phrase in the text box and the article on your word or phrase displayed in the Article 
Window.
 If you clicked the Encyclopedia Find button, the Find Tab opens with your word or phrase in 

the text box, and the list of articles that contain your word or phrase in the list box. The first 
article on the list is displayed in the Article Window.
For more information on QuickShelf see:

Accessing Bookshelf from Other Applications Using QuickShelf

What's in the Encyclopedia Tabbed Lists
The Encyclopedia Contents Tabbed List
The encyclopedia Table of Contents lists all the articles in the encyclopedia, in alphabetic 
order.    If Contents isn't open, just click the Contents Tab. Start to type the word or phrase 
you're looking for in the text box at the top of the Contents list, and then watch as the list 
scrolls to your word. The Contents feature locates your word or phrase in the title of the 
article. Click the article title in the list to open the article. Notice that the list items are 
marked with either a tiny arrow picon or a tiny book icon. The book icon indicates a single 
article, the arrow picon indicates a general category that includes several articles. When you
click a list item with an arrow picon, the first article in its sublist will appear.
The Encyclopedia Find Tabbed List
When you want to search through all the articles in the encyclopedia that contain a certain 
word or phrase use the Find Tab. Using Find is a handy way to add to the information you 
collect using the Table of Contents. Just click the Find Tab, type the word or phrase in the text
box, and then click the Find button. Bookshelf will give you a list of all the articles with the 
item you're looking for. The Find feature locates your word or phrase anywhere in any article.
Click a list item to see the article.    
The Encyclopedia Gallery Tabbed List
When you want to browse through all the multimedia items in the encyclopedia, click the 
Gallery Tab. The encyclopedia has lots of media to explore. In the Encyclopedia Gallery, click 
any of the media buttons to see a list of all the articles that contain multimedia elements. 
Use the scroll bar to browse through the list. Click a list item to open the article.
To close the Encyclopedia:
    Click another book icon on the Book Bar.
    Choose a different book from the Books menu.
    To close the encyclopedia and all of Bookshelf, too, click the Control-menu box in the 

upper-left corner of the Bookshelf window, and then click Close.
See Also

Playing an Animation, Video Clip, or Demo
How the Main Window Works
How to Find Your Way Around Bookshelf
Using the Buttons on the Article Window



 About The Columbia Dictionary of Quotations
The Columbia Dictionary of Quotations has more than 18,000 lively remarks, judgments, and
observations on 1,500 subjects, most of them contemporary.
In the quotations book, each quotation is called an article. The quotations book articles are 
organized alphabetically by subject, and within each subject articles are organized 
alphabetically by the person quoted. For example, if you needed a quote on the subject of 
"Technology" you could browse through numerous quotations on that topic from A. J. Ballard 
to Henry David Thoreau. 
To see copyright information, open to the quotations book Contents screen and click the 
>Page button.
Now you can take advantage of this powerful quotation book from any application in 
Windows simply by clicking a button on the QuickShelf feature.
The Quotations Book Article Window
When the quotations book opens you see its main window. The Article Window is the part of 
the main window where you read a quotation.
Locating Articles in the Quotations Book
There are several ways to look for words in the quotations book. 
    Bookshelf can look for a word or phrase in the Quotations Table of Contents list. Just click 

the Quotations icon in the Book Bar, then type the word or phrase youre looking for in the 
Contents Tabbed List (if its closed, click the Contents Tab to open it), and then select an 
article title when it appears in the list.
    Perform a full-text search on a word or phrase in the quotations book by clicking the 

Quotations icon in the Book Bar, and then clicking the Find Tab to open the Find Tabbed List 
box, typing the word or phrase you're seeking in the text box, and then clicking the Find 
button. Bookshelf will find all the articles in the quotations book where your word or phrase 
appears.
    Click the Back List Tab to see a list of articles you've already looked at since you turned on

Bookshelf. Click an article title in the list to go back to it, if you want.
    After you've found an article, browse through nearby articles in either alphabetic or 

reverse alphabetic order by clicking the <Page or the >Page buttons at the bottom of the 
article window. You can also click the Previous or the Next buttons at the bottom of the 
Tabbed List Box to browse through articles in the current Tabbed List.
 Need a quotation fast? You can right-mouse click any word in Bookshelf, and then choose 

Find In and Quotations from the menus that appear, to perform a full-text search on that 
word in the quotations book.
To use QuickShelf to open the quotations book from another application:
1. In another Windows program, such as Word, highlight a word or phrase.
2. Move the mouse pointer over the buttons on the QuickShelf toolbar to pop up the names 

of    the quotation book buttons.
3. Click the Quotation Contents button on QuickShelf. If Bookshelf is not open, QuickShelf will

open Bookshelf for you and look for your word or phrase.
Alternatively, you can click the Quotation Find button. You will see a message that lets you
know Bookshelf is searching for your word or phrase.
You may need to add quotations book buttons to the QuickShelf Toolbar. This is easy to 
do. See the cross-reference    after Step 4.

4. Bookshelf opens the quotations book.
 If you clicked the Quotations Contents button, the Contents Tab opens with your word or 

phrase in the text box and the article on your word or phrase displayed in the Article 
Window.
 If you clicked the Quotations Find button, the Find Tab opens with your word or phrase in 

the text box, and the list of articles that contain your word or phrase in the list box. The first 



article on the list is displayed in the Article Window.
For more information on QuickShelf see:

Accessing Bookshelf from Other Applications Using QuickShelf

What's in the Quotations Tabbed Lists
The Quotations Book Contents Tabbed List
The Quotations Table of Contents lists all the articles in the quotations book. If Contents isn't 
open, just click the Contents Tab. Start to type the word or phrase you're looking for in the 
text box at the top of the Contents list and watch as the list scrolls to your word. Click the 
article title in the list to open the article. Notice that the list items are marked with either a 
tiny arrow picon or a tiny book icon. The book icon indicates a single article, the picon 
indicates a general category that includes several articles. When you click a list item with an
arrow picon, the first article in its sublist will appear.
The Quotations Find Tabbed List
When you want to search through all the quotations that contain a certain word or phrase, 
use the Find Tab. Using Find is a handy way to add to the information you collect using the 
Table of Contents. Just click the Find Tab, type the word or phrase in the text box, and then 
click the Find button. Bookshelf will give you a list of all the articles with the item you're 
looking for. The Find feature locates your word or phrase anywhere in any article. Click a list 
item to see the article.    
The Quotations Gallery Tabbed List
When you want to browse through all the multimedia items in the quotations book, click the 
Gallery Tab. In the quotations book Gallery click the Picture button. The list of all the 
quotations that have pictures appears. Use the scroll bar to browse through the list. Click a 
list item to open the article.
To close the quotations book:
    Click another book icon on the Book Bar.
    Choose a different book from the Books menu.
    To close the quotations book and all of Bookshelf, too, click the Control-menu box in the 

upper-left corner of the Bookshelf window, and then click Close.
See Also

How the Main Window Works
How to Find Your Way Around Bookshelf
Using the Buttons on the Article Window



 About Longman's Original Roget's Thesaurus
Bookshelf 1994 features the powerful and widely accepted Longman's Original Roget's 
Thesaurus. Using this thesaurus could greatly improve the reach of your writing. Each entry 
is far deeper and contains many more related terms than the typical thesaurus. 
The thesaurus is organized by classes of subject matter. This means that when you are 
reading an article you can browse through related topics by using the <Page or the >Page  
buttons. The thesaurus Table of Contents is organized alphabetically by word or phrase. Each
entry in the thesaurus is called an article. To see copyright information, open to the 
thesaurus Contents screen and click the >Page button.
Now you can take advantage of this powerful thesaurus from any application in Windows 
simply by clicking a button on the QuickShelf feature.
The Thesaurus Article Window
When the thesaurus opens you see its main window. The Article Window is the part of the 
main window where you read an individual thesaurus entry, or article. Each entry in the 
thesaurus consists of a single main word (the keysense word) followed by groups of words 
and phrases that have meanings similar to that of the keysense word. Highlighted words in 
the entry are hot text and can be clicked to jump to other, similar entries in the thesaurus.
You can click the See Also button at the bottom of the thesaurus Article Window to browse 
through related articles. (The See Also button is the same as the See Also command on the 
Tools menu.) If a related-article list is not available, this button is dimmed. Click the Back 
button to go back to articles you've just looked through. 
Locating Articles in the Thesaurus
There are several ways to look for words in the thesaurus. 
    Bookshelf can look for a word or phrase in the Thesaurus Table of Contents list. Just click 

the Thesaurus icon in the Book Bar, then type the word or phrase you're looking for in the 
Contents Tabbed List (if it's closed, click the Contents Tab to open it), and then select an 
article title when it appears in the list.
    Perform a full-text search on a word or phrase in the thesaurus by clicking the Find Tab to 

open the Find Tabbed List box, typing the word or phrase you're seeking, and then clicking 
the Find button. Bookshelf will find all the articles in the thesaurus where your word or 
phrase appears.
    Click the Back List Tab to see a list of articles you've already visited and go back to them 

if you want.
    After you've found an article, browse through nearby articles in the same category by 

clicking the <Page or the >Page buttons at the bottom of the Article Window. You can also 
click the Previous or the Next buttons at the bottom of the Tabbed List Box to browse 
through articles in the current Tabbed List. The Table of Contents is in alphabetic order.
    When you are reading an article you can click a hot word or phrase to jump to a related 

topic.

 Need a synonym in a hurry? You can right-mouse click on any word in Bookshelf, and then 
choose Find In and Thesaurus from the menus that appear, to perform a full-text search on 
that word in the thesaurus. 
To use QuickShelf to open the thesaurus from another application:
1. In another Windows program, such as Word, highlight a word or phrase.
2. Move the mouse pointer over the buttons on the QuickShelf toolbar to pop up the names 

of    the thesaurus buttons.
3. Click the Thesaurus Contents button on QuickShelf. If Bookshelf is not open, QuickShelf 

will open Bookshelf for you and look for your word or phrase.
Alternatively, you can click the Thesaurus Find button. You will see a message that lets 
you know Bookshelf is searching for your word or phrase.



You may need to add thesaurus buttons to the QuickShelf Toolbar. This is easy to do. See 
the cross-reference after Step 4.

4. Bookshelf opens the thesaurus. 
 If you clicked the Thesaurus Contents button, the Contents Tab opens with your word or 

phrase in the text box and the article on your word or phrase displayed in the Article 
Window.
 If you clicked the Thesaurus Find button, the Find Tab opens with your word or phrase in the

text box, and the list of articles that contain your word or phrase in the list box. The first 
article on the list is displayed in the Article Window.
For more information on QuickShelf see:

Accessing Bookshelf from Other Applications Using QuickShelf

What is in the Thesaurus Tabbed Lists
The Thesaurus Contents Tabbed List
When you want to look up a word in the thesaurus, use the Table of Contents. If Contents 
isn't open, just click the Contents Tab. Start to type the word or phrase you're looking for in 
the text box at the top of the Contents list and watch as the list scrolls to your word. Click 
the article title in the list to open the article. Notice that the list items are marked with either
a tiny arrow picon or a tiny book icon. The book indicates a single article, the picon indicates
a general category that includes several books.
The Thesaurus Find Tabbed List
When you want to search through the articles in the thesaurus that contain a certain word or
phrase, use the Find Tab. Using Find is a handy way to add to the information you collect 
using the Table of Contents. Just click the Find Tab, type the word or phrase in the text box, 
and then click the Find button. Bookshelf will give you a list of all the articles with the item 
you're looking for. Click a list item to see the article.    
To close the Thesaurus:
    Click another book icon on the Book Bar.
    Choose a different book from the Books menu.
    To close the thesaurus and all of Bookshelf, too, click the Control-menu box in the upper-

left corner of the Bookshelf window, and then click Close.
See Also

How the Main Window Works
How to Find Your Way Around Bookshelf
Using the Buttons on the Article Window



Help Contents for Bookshelf

To go to a Help topic using the mouse, point to the underlined article title, and then click the 
left mouse button.

To go to a Help topic using the keyboard, press TAB until you highlight the Help topic title, 
and then press ENTER.
Use the scroll bar or press the PAGE DOWN key to see entries not visible in the Help window. 
 Click colored text with a dotted underline to pop up a definition in Help. Click colored text 

with a solid underline to jump to that topic in Help.

How to Use Help

What's in the Seven Books of Bookshelf?

Using Bookshelf: A Guide to the Basics

Using Bookshelf Dialog Boxes

Accessing Bookshelf from Other Applications Using QuickShelf

Working with Windows

Keyboard Shortcuts

Bookshelf Tips and Tricks

Frequently Asked Questions

Glossary of Terms and Error Messages



What's in the Seven Books of Bookshelf?
The special features of each book, its organization, and ways of locating information in it are 
described in the topics below.

About   The American Heritage Dictionary  
About   Longman  '  s Original Roget  '  s Thesaurus  
About   The Concise Columbia Encyclopedia  
About   The Columbia Dictionary of Quotations  
About   The Hammond Atlas  
About   The People  '  s Chronology  
About   The World Almanac and Books of Facts 1994  



 How to Use Help
Bookshelf Help is a comprehensive guide to using Bookshelf. Each major section in Help is 
called a topic. This topic introduces the basics you'll need to get started using Help. 
To display Help information, do one of the following:

Press F1.
Choose Help Contents from the Bookshelf Help menu.
Click the Help button in any box that has one for an explanation of the task you're 

working on.
When you're using the Help system, you can locate information in the following ways:

To Do this
Jump to a related Help topic Click a topic title with colored text and a solid underline.
Display a pop-up description Click a word or phrase with colored text and a dotted 

underline.
Browse through Help topics Click the <<   button   or >>   button  .
Go back to last Help topic Click the Back button.
Use a list of previous topics Click the History button and then choose a Help topic from 

the list.
Scroll through text Use the scroll bar or press the PAGE DOWN key.
Use the Help Search feature Click the Search button, choose an entry, choose a related 

Help topic, and then click Go To.
Display the Help Table of Contents Click the Contents button.
To quit Help:

Double-click the Control-menu box in the upper-left corner of the Help window.
See Also
Keyboard Shortcuts



Contents button 
Displays the Contents screen for Help.



Search button
Click to display the Search box, where you can either type a Help search entry or scroll to 
select a search entry in the top box. Click Show Topics to see all the Help topics related to 
your search entry in the bottom box. Click a topic name and then click Go To (or double-click 
a topic name) to jump to the topic.



Back button
Displays the last Help topic you viewed.



History button
Displays a list of the last 40 Help topics you viewed. Double-click a topic in the list to display 
that topic again.



>> button 
Displays the next topic in Help.



<< button 
Displays the previous topic in Help.



 About The Hammond Atlas
The Hammond Atlas contains up-to-date political and topographic maps of the continents, 
countries, and U.S. regions. In addition, the atlas has flags of countries and the states in the 
United States, plus many national anthems you can listen to. The atlas is linked to the 
encyclopedia and the almanac, so access to detailed information about a particular region is 
only a click away. To see copyright information, open to the atlas Contents screen and click 
the >Page button.
The atlas is organized in levels of successively detailed maps. Each entry in the atlas is 
called an article.

 Level one offers a world map with continents, large islands, and major regions 
outlined.

 Level two offers maps of continents, large islands, and major regions. At this level 
are maps of a few countries, such as the United States (with states), Canada (with provinces 
and cities), and Japan (with cities). Topographic maps are also available.

 Level three offers maps of countries (with cities) of the world and regions of the 
United States (with states and cities). Topographic maps are also available.
You can now use the atlas from any application in Windows simply by clicking a button on 
the QuickShelf feature.
The Atlas Article Window
When the atlas opens you see its main window. The Article Window is the part of the main 
window where you explore the maps and the other information you can find in the atlas. 
Move the mouse pointer over a place name. When it turns into a hand, click it to hear the 
name of the place pronounced. 
Click a flag in any map to display a Country or State Information box. In this box you may 
have several options available--such as seeing the flag, listening to the anthem, copying the 
flag, opening an article in the almanac or the encyclopedia, or listening to the place name 
pronounced. Click the close box in the upper-left corner to close the boxes. (You can also 
click outside the boxes to close them.)
You can click the Flags command on the Tools menu to browse through all the flags in the 
Bookshelf atlas and copy flags to other programs.
Use the buttons on the atlas article window to see specialized maps. Click the Topography 
Map button in the upper-right corner to see a topographic map of the region you are 
currently examining. (This button is the same as the Topography command on the Tools 
menu.) Click again to close the map. Click the Locator button on the bottom of the Article 
Window to see the relative position of the region in the world. Click again to close the 
Location Map. (This button is the same as the Locator Map command on the Tools menu.)
Locating Maps in the Atlas
There are several ways to look for maps in the atlas. 
    Try navigating in the atlas by clicking on the maps. When you first open the atlas, click 

the Locator button at the bottom of the Article Window to open the map of the world. (This 
button is the same as the Locator command on the Tools menu.) Click a place, such as the 
United States, to zoom in closer. Click a region in the United States to see maps of individual
states. To move elsewhere on the map, click one of the black direction arrows.

 Notice that the mouse pointer changes to a hand when it is over an area you can click 
to see another map or a dialog box.
    Bookshelf can look for a place name in the atlas Table of Contents list. Just click the Atlas 

icon in the Book Bar, then type the name of the place you're looking for in the Contents 
Tabbed List (if it's closed, click the Contents Tab to open it), and then select an map title 
when it appears in the list.
    Start a full-text search on a place name in the atlas by clicking the Atlas icon in the Book 

Bar, and then clicking the Find Tab to open the Find Tabbed List box. Then type the name of 
the place you're seeking in the text box, and click the Find button. Bookshelf will find all the 



maps in the atlas where your place name appears.
    Click the Back List Tab to see a list of articles you've already looked at since you turned on

Bookshelf. Click an article title in the list to go back to it, if you want.
    After you've found a map, browse through maps of nearby geographic locations by 

clicking the <Page or the >Page buttons at the bottom of the article window. You can also 
click the Previous or the Next buttons at the bottom of the Tabbed List Box to browse 
through map titles in the current Tabbed List.
    Do you want to see a topographic map of a region? First open the map of the region, then 

click the Topographic map button in the upper-right corner of the Article Window to see a 
topographic map. Click again to close the map.
 Need a map in a hurry? You can right-mouse click any place name in Bookshelf, and then 

choose Find In and Atlas from the menus that appear, to perform a full-text search on that 
word in the atlas.
To use QuickShelf to open the atlas from another application:
1. In another Windows program, such as Word, highlight a word or phrase, such as a place 

name.
2. Move the mouse pointer over the buttons on the QuickShelf Toolbar to pop up the titles of 

the atlas buttons.
3. Click the Atlas Contents button on QuickShelf. If Bookshelf is not open, QuickShelf will 

open Bookshelf for you and look for your place name.
Alternatively, you can click the Atlas Find button. You will see a message that lets you 
know Bookshelf is searching for your place name.
You may need to add atlas buttons to the QuickShelf Toolbar. This is easy to do. See the 
cross-reference after Step 4.

4. Bookshelf opens the atlas. 
 If you clicked the Atlas Contents button, the Contents Tab opens with your place name in 

the text box and the map showing the place displayed in the Article Window.
 If you clicked the Atlas Find button, the Find Tab opens with your place name in the text 

box, and the list of articles that contain your place name in the list box. The first map on the 
list is displayed in the Article Window.
For more information on QuickShelf see:

Accessing Bookshelf from Other Applications Using QuickShelf

What's in the Atlas Tabbed Lists and    Article Window
The Atlas Contents Tabbed List
 The atlas Table of Contents lists all the maps in the atlas, in alphabetic order. If Contents 
isn't open, just click the Contents Tab. Start to type the name of the place you're looking for 
in the text box at the top of the Contents list, and then watch as the list scrolls to your word. 
Click the article title in the list to open the article. Notice that the list items are marked with 
either a tiny arrow picon or a tiny book icon. The book icon indicates a single article, the 
arrow picon indicates a general category that includes several articles. When you click a list 
item with an arrow picon, the first article in its sublist will appear.
The Atlas Find Tabbed List
When you want to see a list of all the maps in the atlas that use a certain name use the Find 
Tab. Using Find is a handy way to add to the information you collect using the Table of 
Contents. Just click the Find Tab, type the place name in the text box, and then click the Find 
button. Bookshelf will give you a list of all the maps with the item you're looking for. Click a 
list item to see the article.    
The Atlas Gallery Tabbed List
When you want to browse through all the multimedia items in the atlas, click the Gallery Tab.
In the Atlas Gallery, click the All Media button to see a list of all the maps that contain the 
different multimedia items. Use the scroll bar to browse through the list. Click a list item to 



open the article.
To close the atlas:
    Click another book icon on the Book Bar.
    Choose a different book from the Books menu.
    To close the atlas and all of Bookshelf, too, click the Control-menu box in the upper-left 

corner of the Bookshelf window.
See Also

Flag Browser Dialog Box Description
How the Main Window Works
How to Find Your Way Around Bookshelf
Using the Buttons on the Article Window



 About The World Almanac and Book of Facts 1994
The World Almanac and Book of Facts 1994 is a general reference book of statistical data, 
contemporary facts, geographic information, and trivia. The entries in each section are 
called articles. The articles in this book are organized in different categories based on 
subject matter, such as Arts & Media, Chronology 1993, Nations of the World, People, 
Science and Technology, Sports, The United States, and World History.
Some articles contain hot footnotes in superscript. You can click these footnotes to see 
further information. To see copyright information, open to the almanac Contents screen and 
click the >Page button.
Now you can take advantage of the almanac from any application in Windows simply by 
clicking a button on the QuickShelf feature.
The Almanac Article Window
When the almanac opens you see its main window. The Article Window    is the part of the 
main window where you read an almanac article. The title is at the top of the article. Directly
above the title is the subject-matter category. To see other articles in the same category 
click the >Page or <Page buttons at the bottom of the Article Window.
Locating Articles in the Almanac
There are several ways to look for information in the almanac. 
    Bookshelf can look for a word or phrase in the Almanac Table of Contents list. Just click 

the Almanac icon on the Book Bar, then type the word or phrase you're looking for in the 
Contents Tabbed List (if it's closed, click the Contents Tab to open it), and then select an 
article title when it appears in the list.
    Start a full-text search on a word or phrase in the almanac by clicking the Almanac icon in

the Book Bar, and then clicking the Find Tab to open the Find Tabbed List box. Then type the 
word or phrase you're seeking in the text box, and click the Find button. Bookshelf will find 
all the articles in the almanac where your word or phrase appears.
    Click the Back List Tab to see a list of articles you've already looked at since you turned on

Bookshelf. Click an article title in the list to go back to it, if you want.
    After you've found an article, browse through other articles in the same subject category 

by clicking the <Page or the >Page buttons at the bottom of the article window. You can also
click the Previous or the Next buttons at the bottom of the Tabbed List Box to browse 
through articles in the current Tabbed List.
    When you are reading an article you can click a hot word or phrase to jump to a related 

topic.
 You can right-mouse click any word in Bookshelf, and then choose Find In and Almanac 

from the menus that appear, to perform a full-text search on that word in the almanac.
To use QuickShelf to open the almanac from another application:
1. In another Windows program, such as Word, highlight a word or phrase.
2. Move the mouse pointer over the buttons on the QuickShelf toolbar to pop up the names 

of    the almanac buttons.
3. Click the Almanac Contents button on QuickShelf. If Bookshelf is not open, QuickShelf will 

open Bookshelf for you and look for your word or phrase.
Alternatively, you can click the Almanac Find button. You will see a message that lets you 
know Bookshelf is searching for your word or phrase.
You may need to add almanac buttons to the QuickShelf Toolbar. This is easy to do. See 
the cross-reference after Step 4.

4. Bookshelf opens the almanac. 
 If you clicked the Almanac Contents button, the Contents Tab opens with your word or 

phrase in the text box and the article on your word or phrase displayed in the Article 
Window.
 If you clicked the Almanac Find button, the Find Tab opens with your word or phrase in the 

text box, and the list of articles that contain your word or phrase in the list box. The first 



article on the list is displayed in the Article Window.
For more information on QuickShelf see:

Accessing Bookshelf from Other Applications Using QuickShelf

What's in the Almanac Tabbed Lists
The Almanac Contents Tabbed List
The almanac Table of Contents lists all the articles in the almanac, in alphabetic order.    If 
Contents isn't open, just click the Contents Tab. (Be sure first to click the Almanac icon in the
Book Bar.) Start to type the word or phrase you're looking for in the text box at the top of the
Contents list, and then watch as the list scrolls to your word. The Contents feature locates 
your word or phrase in the title of the article. Click the article title in the list to open the 
article. Notice that the list items are marked with either a tiny arrow picon or a tiny book 
icon. The book icon indicates a single article, the arrow picon indicates a general category 
that includes several articles. When you click a list item with an arrow picon, the first article 
in its sublist will appear.
The Almanac Find Tabbed List
When you want to search through all the articles in the almanac that contain a certain word 
or phrase use the Find Tab. Using Find is a handy way to add to the information you collect 
using the Table of Contents. Just click the Find Tab, type the word or phrase in the text box, 
and then click the Find button. Bookshelf will give you a list of all the articles with the item 
you're looking for. The Find feature locates your word or phrase anywhere in any article. 
Click a list item to see the article.    
The Almanac Gallery Tabbed List
When you want to browse through all the multimedia items in the almanac, click the Gallery 
Tab. The almanac has lots of media to explore. In the almanac Gallery, click any of the media
buttons to see a list of all the articles that contain multimedia elements. Use the scroll bar to
browse through the list. Click a list item to open the article.
To close the almanac:
    Click another book icon on the Book Bar.
    Choose a different book from the Books menu.
    To close the almanac and all of Bookshelf, too, click the Control-menu box in the upper-left

corner of the Bookshelf window, and then click Close.
See Also

Playing an Animation or Video Clip
How the Main Window Works
How to Find Your Way Around Bookshelf
Using the Buttons on the Article Window



Using Bookshelf: A Guide to the Basics
The books in Bookshelf open easily with a click of the mouse or a tap of a key. You can then 
move rapidly from article to article or book to book. The interactive features of Bookshelf 
make the process of looking up and cross-referencing information fast and fun.
 To close this or any other Help window, click the Control-menu box in the upper-left corner, 

and then click Close.
For more information, click a topic:
How the Main Window Works
How to Find Your Way Around Bookshelf
Using the Menu Commands to Get the Most Out of Bookshelf
Using the Book Bar to Open Books
Using the Tabbed Lists to Locate Information

Looking Up an Article in the Table of Contents
Performing a Full-Text Search with Find
Find Hints: How to Narrow the Scope of a Find
Using Advanced Find
Looking for Multimedia Items in the Gallery
Using the Back List to Reread Articles

Using the Article Window to Explore Information
Getting a Definition from any Article in Bookshelf
Infinite Links: Using the Right-Click Shortcut Menu
Choosing Hot Text and Graphics
Using the Buttons on the Article Window

Playing Sounds, Animations, Video Clips, and the Demo
Copying and Printing from a Book
Adding a Note to an Article

Copying and Pasting into a Note



How the Main Window Works
The main window consists of the Book Bar, the Menu Bar, the Tabbed List Area, and the 
Article Window. Bookshelf is arranged so you can use these areas together easily when 
looking things up. You choose a book in the Book Bar, look up information in the Tabbed List 
Area, and read it in the Article Window. Because you can always see these main areas, you 
can perform the most common activities--looking things up, browsing search results, reading
articles, and changing books--without any complex navigation.
Make using Bookshelf easier by taking some time to explore the way the parts of the main 
window work:
 The Book Bar, across the top of the Article Window, is where you choose a book and keep 

track of the open book.
 The Menu Bar, at the top left, is where you can choose a book or perform different 

functions with the text, such as adding a note, copying, using Advanced Find, or getting 
Help!
 The Tabbed List Area, to the left, is where you look for information, using one of Bookshelf's

four convenient "look up" tabs: Contents, Find, Gallery, and Back List.
 The Article Window, to the right, is where you read an article in the open book. This is 

where definitions, quotations, thesaurus synonyms, encyclopedia entries, atlas maps, 
almanac lists, and chronology topics appear.
See also
Opening a Book
Looking Up an Article
Moving in a Book



How to Find Your Way Around Bookshelf
When you use Bookshelf you'll want to do a few basic things. You'll want to open a book, 
look for information, and move quickly through the book to find the things you need. The 
following Help topics answer your basic questions about getting started in Bookshelf. 
 To close this or any other Help window, click the Control-menu box in the upper-left corner, 

and then click Close.
Click a title to jump to the Help topic.

Opening a Book
Looking Up an Article
Moving in a Book



Opening a Book
Bookshelf gives you multiple pathways to its information. Depending on where you are and 
what you are doing, you have several choices for opening a book. 
You can open a book in Bookshelf by:

Clicking a Book icon in the Book Bar.
Clicking an article title in a Tabbed List.
Clicking a book in the Books menu. 
Using the right mouse button to Right-click on any word in Bookshelf and then using 

a short-cut menu to open a related article in another book.
You can open a book from another Windows program by:
 Highlighting a word, and then using the QuickShelf feature to look up what you need in 

Bookshelf.
 The opening screen for a book is called the Contents screen.

To open a book using the Book Bar:
Click a  book icon on the Book Bar at the top of the Bookshelf screen, to open its 

Contents screen and its Table of Contents Tabbed List.
To open a book using a Tabbed List:
1. Click a tab to open one of the four Tabbed Lists.

The Contents Tab is the default.
2. Depending upon which Tabbed List you want to use, do one of the following:
 In Contents, use the text box to type the word or phrase you want to look up. Notice how 

the list scrolls to your word as you type. You can also use the vertical scroll bar to scroll 
through the list until you see the article title you want.
 In Find, use the text box to type the word or phrase you want to use for your full-text 

search. Then click the Find button.
 In Gallery, click a media button, and then scroll through the list until you see an article title 

that you want to open.
 In Back List, scroll through the list of article titles.

3. In your list, you may see items marked with a tiny arrow picon. Click one of these items to
see related article titles in several books.

4. Click a list item marked with a small book icon to open the article.
Look at the book icons in the Book Bar--the open book is indicated by the Open Book icon.

 If you move the mouse pointer slowly over the small book icons in the list, the names 
of the books will pop up.
To open a book using the Books menu:
1. Click the Books menu.
2. Click the name of the book you want.
To open a book with a right-mouse click:
1. Right-mouse click on any word in Bookshelf.
2. On the short-cut infinite links menu that appears, click Find In, and then click the book you

want.
To open a book from outside of Bookshelf:
1. In another Windows program, highlight a word or phrase.
2. Move the mouse pointer over the buttons on the QuickShelf toolbar to locate the book you

want to look in and the feature (either Contents or Find) you want to use.
3. Click a button on the QuickShelf toolbar. If Bookshelf is not open, QuickShelf will open 

Bookshelf for you and look for your word or phrase.
If you click a QuickShelf Find button, you will see a message letting you know Bookshelf is 
searching for your word or phrase.

4. Bookshelf opens to the book you were looking in. 
 If you used the Contents feature, the Contents Tab opens with your word or phrase in the 



text box and the article on your word or phrase displayed in the Article Window.
 If you used the Find feature, the Find Tab opens with your word or phrase in the text box, 

and the list of articles that contain your word or phrase in the list box. The first article on the
list is displayed in the Article Window.
5. In either Tabbed List box, click an item on the list to jump to a Bookshelf article.
6. To return to the other application, click the Control-menu box in the upper-left corner of 

Bookshelf, click Switch To, click the other application's name in the list, and then click the 
Switch To button.

 You may need to add buttons to the QuickShelf toolbar. It is easy to do. To see how, click 
Accessing Bookshelf From Other Applications Using QuickShelf.
See Also
Looking Up an Article



Looking Up an Article
Make looking things up in Bookshelf easier by taking some time to explore the way the main 
window works. The main window is divided into four parts:
 The Article Window to the right.
 The Tabbed Lists to the left.
 The Book Bar across the top of the Article window.
 The Menu Bar at the top left, above the Book Bar.

The main window is arranged so you can work with these four areas easily when using 
Bookshelf. Because you can always see each main area, you can perform the most common 
activities--such as looking things up, browsing search results, or changing books--without 
losing your bearings.
Click a book icon in the Book Bar to open a book. You can click All Books to look in all the 
articles in Bookshelf. Notice when you click a book icon it changes to an open book icon. This
open book lets you know which book you're in.
To start looking articles up in the book you've opened, click a tab. (The default tab is the 
Contents Tab.) When you click a tab, you open one of the four Tabbed Lists. Each Tabbed List
gives you a different way to access Bookshelf's information: 
 Use the Contents Tab to look up articles in the Table of Contents for each book or All Books.
 Use the Find Tab if you want to perform a full-text search using a particular word or phrase. 
 Use the Gallery Tab to browse through all of Bookshelf's multimedia items.
 Use the Back List Tab to see a list of up to 40 articles you've already looked up since you 

started Bookshelf, and go back to them if you want.
To look up an article using the Contents Tab:
1. In the Book Bar, open a book by clicking a book icon.
2. If the Contents Tabbed List is not open, click the Contents Tab.

The Contents Tabbed List opens.
3. Do one of the following:
 In the text box, start typing the word or phrase that describes the article you're looking for. 

Notice that the list scrolls to your word as you type.
 Use the vertical scroll bar to scroll through the list until you find the list item you want.

Notice that list items are marked with tiny arrow picons or tiny book icons. An arrow 
picon to the left of a list item indicates a grouping of similar articles. A tiny book icon tells 
you which book the list item is in.
4. Click a list item to open an article. 

For list items marked with an arrow picon, the first article in the subgroup opens.
5. Click the close box in the upper-right corner to close the Contents Tabbed List. (To open 

the Tabbed Lists again, just click any tab.)

 The Table of Contents stays open while you're exploring in the Article Window. If you want 
to see another article in the same book, just repeat the procedure you used, above.    If you 
want to look in the Table of Contents for another book, or the Table of Contents for all of 
Bookshelf, click another book icon or the All Books icon in the Book Bar, and the Contents 
Tabbed List will change to the list for the book you choose.
To perform a full-text search for a word or phrase using the Find Tab:
1. In the Book Bar, open a book by clicking a book icon.
2. Click the Find Tab.

The Find Tabbed List opens.
3. In the text box, type the word or phrase you want to use for your full-text search. (Find 

doesn't distinguish between uppercase letters and lowercase letters.)
Put quotation marks around phrases. If you don't, you will find all the articles that contain 
each word in the phrase rather than all the articles that contain the phrase. Read the Find 



Hints topic in Help for more suggestions (see the See Also list, below).
4. Click the Find button. Bookshelf looks through all the articles in the selected books for 

your word or phrase.
5. Bookshelf displays the list of all the articles it found in the Find Tabbed List.

Notice that list items are marked with tiny arrow picons or tiny book icons. An    arrow 
picon to the left of a list item indicates a grouping of similar articles. A tiny book icon tells 
you which book the list item is in.

6. Click an article title on the list.
The article opens. The Find Tabbed List stays open, so you can select other articles to look
through.

7. Click the close box in the upper-right corner to close the Find Tabbed List. (To open the 
Tabbed Lists again, just click any tab.)

 If you want to focus your full-text search even more precisely, try using the Advanced 
Find command on the Tools menu.
See Also
Opening a Book
Moving in a Book
Looking Up an Article in the Table of Contents
Performing a Full-Text Search with Find
Find Hints: How to Narrow the Scope of a Find
Using Advanced Find



Moving in a Book
Once you've opened a book, Bookshelf gives you several ways to move through it. Try using 
the Tabbed Lists, the buttons on the Tabbed Lists and Article Windows, and the hot text in 
the articles. A    really handy shortcut to new articles is to right-click on any word and then 
choose a selection from the infinite links menu. In addition you can:
    Look up another article title (use the Contents Tab).
 Perform a full-text search on a word, phrase, or number (use the Find Tab).
    Browse through articles with multimedia (use the Gallery Tab).
    Revisit articles you've already read (use the Back List Tab).
    Jump to a related article (click hot text in the article).
    Browse through articles in the Tabbed List you have open (click the Previous and Next 

buttons in the Tabbed List box).
    Browse through articles in sequence in the open book (click the <Page    and >Page 

buttons in the Article Window).
    Go back to the article you just read (click the Back button in the Article Window).

To display the next article in a book:
Click the >Page button at the bottom of the Article Window, or press CTRL + >. If there

is no article to view next, the >Page button is dimmed.
To display the previous article in a book:

Click the <Page button at the bottom of the Article Window, or press CTRL + <. If there
is no previous article to view, the <Page button is dimmed.
To backtrack through articles in the order in which you viewed them:

Click the Back button at the bottom of the Article Window, or press CTRL + Z.    If there 
is no previous article to view, the Back button is dimmed. 
To return to an article you viewed previously:
1. Click the Back List Tab or press CTRL+ B.

The Back List Tabbed List opens, with a list of up to 40 of the articles you have viewed 
since you started Bookshelf. Bookshelf keeps a record of articles viewed for the current 
session only.
If necessary, use the scroll bar to see more articles.

2. Click the title of the article you want to view.
The Back List Tabbed List stays open on the left side of the screen until you close it or 
open another Tabbed List.

3. Click the Close button at the upper-right of the Tabbed List box to close it.
To display the previous article in a Tabbed List:
 Click the Previous button at the bottom of the Tabbed List.

To display the next article in a Tabbed List:
 Click the Next button at the bottom of the Tabbed List.

See Also
Using the Buttons on the Article Window
Choosing Hot Text and Graphics
Resizing a Window
Moving a Window



 Using Menu Commands to Get the Most Out of Bookshelf
This Help topic briefly describes the commands on each Bookshelf menu. The Bookshelf 
menu is located at the upper left of the screen, above the Book Bar.
The Control-menu commands are also explained. The Control menu is a Windows feature. It's
located at the upper-left corner of all windows and many dialog boxes.
 When reading this Help topic remember, clicking colored text with an underline will display 

a pop-up definition. Clicking underlined text of another color will cause a jump to another 
Help topic. You can quickly return to a Help topic by clicking the Help Back button. (You can 
change the colors of the pop-up and jump text by choosing the Options command on the 
Tools menu.)
To close this or any Help topic, click the Control-menu box in the upper-left corner of the Help
window, and then click Close.
You choose a command by clicking it with the mouse or by using a keyboard shortcut. (For 
more information on using keyboard shortcuts, see Choosing Menus, Commands and Tabs 
with Keys.)
File Menu Commands
Print Article Displays the Print Dialog Box, where you can choose options 

to print the article you have open (assuming you have a 
printer installed and turned on). Click the Setup button to 
change printers and printer settings in the Print Setup 
Dialog Box. A message box appears telling you the article is 
being printed. For more information, see Print Dialog box 
Description and Print Setup Dialog Box Description.

Exit Closes Bookshelf.

Edit Menu Commands
Copy Copies the highlighted portion of the displayed article onto 

the Clipboard. If nothing is highlighted, the Copy command 
copies the entire article onto the Clipboard.

Copy Picture Places a copy of the displayed picture onto the Clipboard. 
(This command is available only when the displayed article 
contains a picture you can copy.) For more information, see 
Copying a Picture.

Copy Audio Places a copy of the sound associated with the displayed 
audio icon onto the Clipboard. (This command is available 
only when the displayed article contains a sound you can 
copy.) For more information, see Copying an Audio Clip or 
Pronunciation.

Copy to Word Sends copied items directly to a location you choose in a 
Word document via the Copy to Word dialog box. For more 
information, see Copy to Word Dialog Box Description.

Note Displays a dialog box in which you can add your own notes 
to the displayed article and keep a list of articles of interest 
to you. For more information, see Note Dialog Box 
Description.

Tools Menu Commands
Table of Contents Displays the Contents Tabbed List Box, in which you can look

up    an article in the Table of Contents list for the open book,
or for All Books. For more information, see Looking Up an 
Article in the Table of Contents.

Find Displays the Find Tabbed List Box, in which you can perform 



a full-text search on a word or phrase in the open book, or in
All Books. For more information, see Performing a Full-Text 
Search with Find.

Gallery Displays the Gallery Tabbed List Box, in which you can 
browse through Bookshelf's animations, video clips, audio 
clips, and pictures. For more information, see Looking for 
Multimedia Items in the Gallery.

Back List Displays the Back List Tabbed List Box, which contains a list 
of up to 40 topics you have read in the current Bookshelf 
session. For more information, see Using the Back List to 
Reread Articles.

Advanced Find Displays the Advanced Find dialog box, in which you can 
select options to focus your full-text search. For more 
information, see Advanced Find Dialog Box Description.

Options Displays a box in which you can specify the colors you want 
for the jump text and pop-up text in the Bookshelf window. 
For more information, see Options Box Description.

See Also When the thesaurus or encyclopedia is open, you will see 
this command. Use it to open a list of cross-references for 
the current article.This command is the same as the See 
Also button. For more information, see Using the Buttons of 
the Article Window. 

Flags When the atlas is open, you will see this command. Use it to 
open a dialog box where you can browse through the flags 
of the countries of the world and the states of the United 
States. For more information, see Flag Browser Dialog Box 
Description.

Locator When the atlas is open, you will see this command. Use it to 
see the relative position of the place on the current map. 
This command is the same as the Locator button. For more 
information, see About   The     Hammond Atlas  .

Topography When the atlas is open, you will see this command. Use it to 
see a topographic map of the place on the current map. This
command is the same as the Topography button in the 
upper-right corner of the Atlas Article Window. For more 
information, see About   The     Hammond Atlas  .

Books Menu Commands
[book title] Lists the title of each book in Bookshelf, plus All Books. 

Choose a book to display its contents screen in the Article 
Window.

Help Menu Commands
Copyright Information Gives you Bookshelf copyright information. To see copyright 

information on each book, click >Page on the book's 
Contents screen.

Help Contents Opens the Help window and displays the Help Contents 
screen.

Bookshelf Demo Starts the Bookshelf Demo, which gives you an overview of   
Bookshelf basics. 

Using Help Opens the Help window and displays information about how 
to use Help.



Keyboard Shortcuts Opens the Help window and displays a list of Help keyboard 
topics. Keyboard topics contain tables of keys and their 
functions in Bookshelf.

About Microsoft Bookshelf Gives you some basic information about Bookshelf.

Control Menu Commands
The Control menu appears in the upper-left corner of all Bookshelf windows and many dialog
boxes. You can double-click the Control-menu box to close any window or box. A single click 
opens the Control menu. This menu may contain any or all of the following commands:
Restore Returns the window to its previous size after it has been 

minimized or maximized.
Move Lets you move the window or box using arrow keys. (If the 

window is maximized, you must restore it before you can 
use this command.)

Size Lets you change the size of the window using arrow keys. (If 
the window is maximized, you must restore it before you can
use this command.)

Minimize Reduces the window to an icon.
Maximize Enlarges the window to take up the full screen.
Close Closes the window or box. You can also double-click the 

Control-menu box to close it.
Switch To Displays a dialog box in which you can choose options to 

arrange windows in different ways, switch among open 
Windows applications, and close down tasks. For more 
information, see Task List Dialog Box Description.

For more information see the following topics:
How the Main Window Works
Opening a Book
Looking Up an Article
Moving in a Book



Using the Book Bar to Open Books
When you want to look up information in Bookshelf, the Book Bar is where you begin. You 
click a book icon in the Book Bar, then look up information in the Tabbed List Area, and read 
it in the Article Window. The icons on the Book Bar give you an easy way to open books and 
then change between books. The Book Bar is a part of every screen in Bookshelf--this means
you can click a book icon at any time to open and look things up in that book. It's a simple 
and intuitive process that makes looking for information easy.
The Book Bar consists of the "Microsoft Bookshelf '94" text, an All Books icon, and a book 
icon representing each book in Bookshelf. The Book Bar is located directly under the 
Bookshelf title and menu bar. Move the mouse pointer over the icons on the Book Bar to pop
up their names. From left to right the books are in this order: All Books, dictionary, 
thesaurus, quotations, encyclopedia, atlas, chronology, and almanac.
When the book icon is in the open state, it changes to an open book icon. There can only be 
one book open at a time. Each time you start Bookshelf, the open book will be All Books. 
Look for the title of the open book below the open book icon.
You can open books from the Article Window and the Tabbed Lists, as well as from the Book 
Bar. If you open a book from the Article Window or from a Tabbed List, the book's icon in the 
Book Bar will change to an open book icon. In other words, no matter where you open a 
book, you can always check the Book Bar to see the open book.
To open a book using the Book Bar:
1. Click a book icon on the Book Bar.
2. The book's Contents screen opens in the Article Window on the right. The book's Table of 

Contents Tab opens on the left.
If you have been using a tabbed list other than Contents, for example Find, and you click 
a different book icon in the Book Bar, the Find Tab will open instead of the Contents Tab.

3. In Contents, use the text box to type the word or phrase you want to look up. Notice how 
the list scrolls to your word as you type. You can also use the vertical scroll bar to scroll 
through the list until you see the article title you want.
In your list, you may see items marked with a tiny arrow picon. Click one of these picons 
to see a list of related article titles. The first article on the list opens in the Article Window.

4. Click a list item marked with a small book icon to open an article.
For more information, see the following topics:

How the Main Window Works
Opening a Book
Looking Up an Article
Moving in a Book



Using the Tabbed Lists to Locate Information
The Tabbed List area is where you look up information in Bookshelf. This area always stays 
open to the left of the Article Window    so you can quickly and easily locate more 
information. There are four tabs. Each tab gives you a different way to explore Bookshelf:

The Contents Tab helps you find articles by means of a Table of Contents list, similar 
to the Table of Contents in a book.There is a separate Table of Contents for each book, plus 
there is a comprehensive Table of Contents for all the books in Bookshelf.

The Find Tab allows you to search throughout any or all of the seven books for a word,
phrase, or number you specify, similar to the search function in a word-processing program.

The Gallery Tab gathers together all the multimedia in Bookshelf--pictures, 
animations, video clips, and audio clips.

The Back List Tab provides you a handy list of all the articles (up to 40) you've looked 
at since you started Bookshelf.
Choose a list item from a tabbed list by clicking it. You can also choose a list item by 
pressing TAB until the list has the tab focus, pressing the up and down arrows, and then 
pressing ENTER. 
Drag the mouse pointer slowly over the items in the list. Notice that long list items extend 
past the edge of the list box, so you can read the whole list item before choosing to open it.
At the bottom of the Tabbed Lists there are two buttons, Previous and Next. Click the 
Previous button to open the article for the list item above the currently highlighted item. 
Click the Next button to open the article for the list item below the currently highlighted 
item.
 You can close a tabbed list by clicking the close button in the upper-right corner. To reopen, 

just click any tab.
For more information, choose a topic:
Using the Bookshelf Tables of Contents

Looking Up an Article in the Table of Contents
Using the Find Feature

Performing a Full-Text Search with Find
Find Hints: How to Narrow the Scope of a Find
Using Advanced Find

Using the Gallery to Locate Multimedia Items
Looking for Multimedia Items in the Gallery

Using the Book List to Locate Articles
Using the Back List to Reread Articles

Using the Tabbed Lists with the Other Parts of the Main Window
How the Main Window Works
Opening A Book
Looking Up an Article
Moving in a Book



Looking Up an Article in the Table of Contents
Each book in Bookshelf has its own Table of Contents. In addition, there is a comprehensive 
Table of Contents of all Bookshelf books. The Tables of Contents are always available by 
clicking the Contents Tab on the Tabbed Lists area. Each time you start Bookshelf, the All 
Books comprehensive Table of Contents is already open and ready to use.
 Try dragging the mouse pointer slowly over the items in the Contents list. Notice that long 

list items extend past the edge of the list box, so you can read the whole list item before 
choosing to open it.
To look up an article using the Contents Tab:
1. Click a book icon in the Book Bar at the top of the screen to choose a book to look in, or 

choose All Books. 
All Books is the default, so the Table of Contents for all the books is open when you start 
Bookshelf.

2. If the Contents Tab list isn't already open, click the Contents Tab to open it. 
You can also open Contents by choosing Table of Contents from the Tools menu, or by 
pressing CTRL + I .

3. Do one of the following:
 In the text box above the Contents list, start typing the name of the article you're looking 

for. (Contents does not distinguish uppercase letters from lowercase letters.) Notice that the 
list scrolls to your article as you type.
 Use the vertical scroll bar to look through the list until you find the article entry you want. 

Drag the mouse pointer slowly over the tiny book icons at the left of the list items. This pops
up the name of the book that the article is from.
4. Click a list item to open an article.

If you click a list item marked with a tiny book icon, that article opens. If you click a list 
item marked with a tiny arrow picon (which indicates a group of articles on the same 
topic), the first article in the group opens.
The Contents list stays open so you can refer back to it and choose other articles to read.

5. If you'd like, you can click the close box in the upper-right corner of the Contents Tabbed 
List to close it and make more room to read the article. Click any tab to reopen the Tabbed
List Area.

 To take full advantage of Bookshelf's "look up" power, after you use the Contents Tab to
look up article titles, try using the Find Tab to perform a full-text search on a word through 
any or all the Bookshelf books. You may find even more articles!
See Also
Opening a Book
Performing a Full-Text Search with Find 



Performing a Full-Text Search with Find
You can use Bookshelf's Find Tab to perform a full-text search in any or all of Bookshelf 
books. You simply specify the word or phrase you're looking for, and Bookshelf generates a 
list of all the articles in which your word or phrase appears.
When you want to select more options to focus your search, choose the Advanced Find 
command from the Tools menu. 

 Try using Find after you've looked for a word or phrase in the Table of Contents list. It 
may give you more articles to consider.
To perform a full-text search using the Find Tab:
1. Click a book icon in the Book Bar at the top of the screen to choose a book to look in, or 

choose All Books to search in all the books. 
All Books is the default.

2. If the Find Tab list isn't already open, click the Find Tab to open it. 
You can also open Find by choosing Find from the Tools menu, or by pressing CTRL + F.

3. In the text box, start typing the word, phrase, or number you're searching for. (Find 
doesn't distinguish uppercase letters from lowercase letters.)

4. Click the Find! button to start your search.
Bookshelf searches through the book or books you've selected and comes up with a list of
all the articles that contain your search word, phrase, or number. Use the vertical scroll 
bar to look through the list. Drag the mouse pointer slowly over the tiny book icons at the 
left of the list items. This pops up the name of the book that the article is from.
Notice that when you drag the mouse pointer over the list items, long list items extend 
past the edge of the list box, so you can read the whole item before choosing to open it.

5. Click a list item to open an article.
The list of articles found stays open so you can refer back to it and choose other articles 
to read.

6. If you'd like, you can click the close box in the upper-right corner of the Find Tabbed List to
close it and make more room to read the article. Click any tab to reopen the Tabbed List 
Area.

Put quotation marks around phrases that you enter in the text box. If you don't, you will 
find all the articles that contain each word in the phrase rather than all the articles that 
contain the phrase. For more suggestions, see the Help topic, "Find Hints: How to Narrow the
Scope of a Find."
 Bookshelf will not search for words that are in its stop-word list.

See Also
Find Hints: How to Narrow the Scope of a Find
Using Advanced Find



Find Hints: How to Narrow the Scope of a Find
You can narrow the scope of a full-text search when you enter words or numbers in the Find 
feature. Try using the find operators AND, OR, NOT, NEAR, and *. You can enter an operator 
in either lowercase or uppercase letters (for example, "and" is the same as "AND"). If you 
use multiple search operators, they are evaluated from left to right, by default. You can use 
parentheses ( ) to specify a different order--operators within parentheses are evaluated first.

These criteria Search for
honey AND bees Articles containing both the word "honey" and the word 

"bees."
"bees love honey" Articles containing the whole phrase bees love honey. (The 

quotation marks are part of the search criteria.)
honey bees Articles containing "honey" and "bees" (same as honey 

AND bees above). AND is the default operator.
honey OR bees Articles containing "honey" or "bees" or both.
honey NOT bees Articles containing "honey" but not "bees."
honey NEAR bees Articles containing "honey" and "bees" if the two words are 

no more than 50 words apart from each other in the text.
Bee* Articles containing words that start with "bee" (for example, 

bees, beehive, beet). An asterisk substitution for one or 
more characters at the end of a word can be helpful if you 
are unsure of how to spell a word you want to search for.

hon?y Articles containing words that start with "hon" and end with 
"y," with another letter in between. This is a useful 
substitution when you don't know how to spell a word.

honey OR bees AND hives Articles containing "honey" and "hives" or articles containing
"bees" and "hives."

honey OR (bees AND hives) Articles containing just the word "honey" or articles 
containing "bees" and "hives."

 Bookshelf will not look for words that are in its stop-word list.
To close this Help window, click the Control-menu box in the upper-left corner of Help, and 
then click Close.
See Also
Performing a Full-Text Search with Find
Using Advanced Find



Using Advanced Find
You use the Advanced Find feature instead of the Find Tab when you want to precisely focus 
your search for a specific word, phrase, or date. Like the Find Tab, you use Advanced Find to 
perform a full-text search in any or all of Bookshelf books. You simply specify    the word or 
phrase you are looking for, and Bookshelf generates a list of all the articles in which your 
word or phrase appears.
However, with Advanced Find you can narrow your search to one article. You can even 
choose to go back and search again in the articles you've already looked through. In 
addition, when you use Advanced Find you can pick as many books as you want to search 
through.
To perform a full-text search using Advanced Find:
1. From the Tools menu, choose Advanced Find.

The Advanced Find dialog box opens.
2. In the text box, type the word, phrase, or date you want to find.

Click the Hints button to get some suggestions for narrowing the scope of your search.
3. For the "Select Where to Look" options there are three selections:
 Click All Articles (the default) to search through all the articles in the selected books.
 Click Current Article Only to limit your search to the article currently open in the Article 

Window.
 Click Last Articles Found to limit your search to the articles in the list generated by your 

last search.
4. Click the buttons for the books you want to search in. All Books is the default. 

Remember, if you selected the Current Article Only or the Last Articles Found options, 
make sure your book selections match your previous selections.

5. Click Find! Bookshelf looks through the article or articles you've selected to find your 
word, phrase, or date.
The list of all the articles Bookshelf finds appears in the Find Tabbed List Area. Use the 
vertical scroll bar to look through the list. Drag the mouse pointer slowly over the tiny 
book icons at the left of the list items. This pops up the name of the book that the article 
is from.

6. Click a list item to open an article.
The list of articles found stays open so you can refer back to it and choose other articles 
to read.

7. If you'd like, you can click the close box in the upper-right corner of the Contents Tabbed 
List to close it and make more room to read the article. Click any tab to reopen the Tabbed
List Area.

See Also
Performing a Full-Text Search with Find
Find Hints: How to Narrow the Scope of a Find



Looking for Multimedia Items in the Gallery
You can use the Gallery Tab to explore Bookshelf's many multimedia elements. Depending 
upon which book you're looking in or which article you're reading you can enjoy animations, 
video clips, musical examples, pronunciations of words, pictures, and maps. Multimedia 
elements are an important part of the fun of using Bookshelf. The Gallery brings all the 
media elements together. This is where you can, for example, browse through all the 
animations in the encyclopedia.
To look for media elements using the Gallery:
1. Click a book icon in the Book Bar at the top of the screen to choose a book to look in, or 

choose All Books to search in all the books. 
All Books is the default.

2. Click the Gallery Tab to open the Gallery Tabbed List. 
You can also open the Gallery by choosing Gallery from the Tools menu, or by pressing 
CTRL+ G.

3. In the Gallery, click one of the four media type buttons: All Media, Audio, Animation & 
Video, and Picture.
If the book you selected has this type of media, a list of all the articles that contain that 
media type appears. Try dragging the mouse pointer over the list items. Notice that long 
list items extend past the edge of the list box, so you can read the whole item before 
choosing to open it.
You can browse through the list by using the scroll bar, or you can move quickly through 
the list by typing the first letter of the article you are looking for.

4. Click an item on the list to open the article and explore its multimedia.
The list of articles stays open so you can refer back to it and choose other articles to look 
through.

5. If you'd like, you can click the close box in the upper-right corner of the Gallery Tabbed 
List to close it and make more room for the article. Click any tab to reopen the Tabbed List
Area.

See Also
Playing an Animation or Video Clip
Playing an Audio Clip
Copying a Picture
Copying an Audio Clip or Pronunciation 



Using the Back List to Reread Articles
You can use the Back List Tab to look through a list of up to 40 articles you have read since 
you started the current session of Bookshelf. 
To reread articles you've read in the current Bookshelf session:
1. Click the Back List Tab to open the Back List Tabbed List.

The list of articles you have just looked through appears. Try dragging the mouse pointer 
over the list items. Notice that long list items extend past the edge of the list box, so you 
can read the whole item before choosing to open it.

2. Click an article title to open the article again.
The list of articles stays open so you can refer back to it and choose other articles to look 
through.

3. If you'd like, you can click the close box in the upper-right corner of the Back List Tabbed 
List to close it and make more room for the article. Click any tab to reopen the Tabbed List
Area.

See Also 
Using the Buttons on the Article Window



Using the Article Window to Explore Information
The Article Window is where you read the information that you look up in Bookshelf. 
You choose a book in the Book Bar, look up information using the Tabbed Lists, and read it in 
the Article Window. These parts of the main window are always open, so you can see the 
relationship between the Article Window and the two other main screen areas.

The Article Window is even more fun than ever to use, because you can explore new 
shortcuts to Bookshelf's information. Double-click on any word in Bookshelf to see its 
definition in the dictionary. To learn more about this feature, click "Getting a Definition from 
any Article in Bookshelf," below. Right-click on any word or phrase in an article to open the 
Infinite Links shortcut menu that lets you jump quickly to related articles. For more 
information, click "Infinite Links: Using the Right-Click Shortcut Menu," below.

For more information see:
How the Main Window Works
Looking Up an Article
Getting a Definition from any Article in Bookshelf
Infinite Links: Using the Right-Click Shortcut Menu
Choosing Hot Text and Graphics
Using the Buttons on the Article Window



Getting a Definition from any Article in Bookshelf
There is now a really fast way to look up definitions in the dictionary while you're reading an 
article in Bookshelf. You simply double-click on any word in an article and its definition 
appears. This is the same definition that appears when you use the dictionary.
To instantly get a word's definition:
 Double-click on a word in an article in Bookshelf. When you're finished reading the 

definition, close it by clicking the close box in the upper-left corner.
 You can also right-click on a word to open the infinite links menu. Click Define to get the 

word's definition.
See also
Looking Up an Article
Infinite Links: Using the Right-Click Shortcut Menu
Choosing Hot Text and Graphics
Using the Buttons on the Article Window



Infinite Links: Using the Right-Click Shortcut Menu
When you're reading an article, you can access Bookshelf information on any word right 
from the Article Window. Just right-click on any word to open the infinite links shortcut menu.
Use this menu to look up a definition, copy a word onto the Clipboard, copy text to Word for 
Windows, or perform a full-text search on your word in any book in Bookshelf.
To instantly see any word's dictionary definition using the infinite links menu:
1. Using the mouse, right-click on a word in the Article Window to display the infinite links 

menu.
This menu contains several items--you can look up the word's definition, or copy the 
current article, or use the Find In feature to do a full-text search.

2. Click Define on the menu.
A definition appears. This is the same definition that you would read in the dictionary.

3. When you are finished reading the definition, click the close box in the upper-left corner of
the dialog box to close it.

To instantly copy a word onto the Clipboard using the infinite links menu:
1. Right-click on a word in the Article Window.
2. Click Copy on the menu.

This copies the word onto the Clipboard.
3. In another application, or in Bookshelf's Note dialog box, click Paste or press CTRL+ V.

This pastes the word into the other application or the Note.
To instantly copy text to Word:
1.    If you have installed both Bookshelf and Word for Windows, you can use this feature.
2.    Open the article, and right-click the text you want to copy.
3.    Click Copy to Word on the menu.

The Copy to Word dialog box opens.
4. Click to choose an option from the Copy To list:
 New document. Click this option, if Word is not currently open, or if Word is open and you 

want to create a new document.
 Current location. Click this option, if you want to copy text into an open Word document 

right where you left the insertion point.
 End of [document name]. Click this option, if you want to add your text to the end of the 

named document.
5      Click the Copy button to copy and paste the text and close the box. Click the Cancel 

button, if you decide not to copy. Click the Help button, for information on the dialog box.
To instantly do a full-text search using the infinite links menu:
1. Right-click on any word in the Article Window.
2. Click Find In on the menu.
3. From the menu of books click any book title, or All Books.

This activates a full-text search on your word in the book that you've chosen.
4. The list of articles that contain your word appears in the Find Tabbed List Box. The first 

article on that list opens in the Article Window.
The word that you right-clicked on is highlighted in the article.

5. To look at other articles in the Find Tabbed List, just click any article title in the list.
6. To return to the article you were reading when you right-clicked on the word, click the 

Back button at the bottom of the Article Window. This will take you back to articles that 
you have previously read.

See Also
Looking Up an Article
Getting a Definition from any Article in Bookshelf
Choosing Hot Text and Graphics



Performing a Full-Text Search with Find



Choosing Hot Text and Graphics
In Bookshelf, you can click certain text and graphics that are hot to display additional 
information in a pop-up window or jump to another article. When the mouse pointer is over 
hot text or graphics, the pointer changes to a hand.
To display more information in a pop-up window:
1. Click colored text with an underline, and you will see a pop-up definition.

Or click certain pictures to see an enlarged picture. These pictures are labeled "Click to 
enlarge." You can find them in the encyclopedia and the dictionary.

2. Click again to close the pop-up window.
To jump to another article:

Click colored text (the color will be different from that of pop-up text) with an 
underline.

    You can change the color for pop-up text and for jump text by choosing the Options 
command from the Tools menu and then selecting different colors from the Bookshelf 
Options dialog box.
See Also
Choosing Hot Text and Graphics with Keys
Options Dialog Box Description
Playing an Audio Clip
Playing an Animation, Video Clip, or the Demo



Using the Buttons on the Article Window
The standard buttons at the bottom of the Article Window help you navigate through the 
Bookshelf books and copy and print articles. (The buttons at the top of the screen are 
Windows buttons--the Control Menu box, the Minimize button and the Maximize button.)
The thesaurus and encyclopedia have a See Also button you can use to look for cross-
references. The atlas has a Locator button you can use to see the relative location of places 
in the world; the atlas also has a Topography Map button you can use to see a topographic 
map of each location. (These buttons are the same as the commands of the same name that
appear on the Tools menu when you open these books.)
 Some buttons open dialog boxes. To close a dialog box without selecting any options, click 

the Control-menu box in the dialog box's upper-left corner, and then click Close. With some 
dialog boxes, a click on the close box will close it.
Using the Copy Button
Use the Copy button to copy text, pronunciations, or pictures onto the Clipboard so you can 
paste them into other applications or into Bookshelf's Note feature. (There are also Copy 
commands on the Edit menu.) You can use the Copy button to copy the text of an entire 
article. If you want to copy a portion of an article, be sure to select the text before you click 
Copy.
When you click Copy you will see a dialog box that gives you four options:
 Copy Selected Text. This option will be dimmed unless you select text before clicking Copy.
 Copy All Text. This is the default.
 Copy Picture. This will be dimmed if there is no picture that can be copied in the article.
 Copy Pronunciation. This will be dimmed if there is no pronunciation in the article.

Click an option to select it. If you click an option that is already selected you will deselect it. 
Just click it again to select it. Click OK to activate your choice and close the box, or click 
Cancel to close the box without making any selections. 
Using the Print Button
Use the Print button to print an article from Bookshelf. This is the same as the Print Article 
command on the File menu. When you click the Print button, the Print dialog box appears. 
Usually you can just click OK to start your print job. Click Cancel to close the box without 
making any selections. Click Setup to use the Printer Setup dialog box.
Using the Back Button
Click the Back button to backtrack through articles in reverse order.    If there is no previous 
article to view, the Back button is dimmed.
Using the <Page Button
Click the <Page button to display the previous article in the open book's browse order. If 
there is no previous article to view, the >Page button is dimmed.
Using the >Page Button
Click the >Page button to display the next article in the open book's browse order. If there is 
no article to view next, the >Page button is dimmed.
Using the See Also Button
In the thesaurus and encyclopedia, click the See Also button, at the bottom of the Article 
Window, to open a dialog box with a short list of articles on a related subject. Click any 
article on the list to jump to it and close the box. Click the close box in the upper-left corner 
of the dialog box to close it without selecting an article. (This button is the same as the See 
Also command that appears on the Tools menu when you open these books.)
Using the Locator Button
In the atlas, click the Locator button, at the bottom of the Article Window, to open the 
Location maps. If you click Locator on the atlas' contents screen, you will see a map of the 
world. Click a region to see a map. Click Locator when you're viewing a map of a country or 
a state in the United States to see a Location map that gives you the country's or state's 



relative location in the world. Click the arrows on the Location map to see another region. To 
close the Location map, click the screen anywhere outside the map. (This button is the same
as the Locator command that appears on the Tools menu when you open the atlas.)
Using the Topography Map Button
In the atlas, click the Topography Map button, at the upper-right of the Article Window, to 
open a topographic map of the same region as the current map you are viewing. To close the
Topographic Map, click the screen anywhere outside the map. Topographic maps cannot be 
copied or printed. (This button is the same as the Topography button that appears on the 
Tools menu when you open the atlas.)
See Also
Moving in a Book
About The American Heritage Dictionary
About The Columbia Dictionary of Quotations
About The Roget's Thesaurus
About The Hammond Atlas
Copying and Printing from a Book



Playing Sounds, Animations, Video Clips and the Demo
In the quotation book, you can hear some of the quoted persons speaking their memorable 
phrases. In the encyclopedia, you can play animations, videos, and musical examples. To 
play the Bookshelf Demo, choose the command of that name from the Help menu.
For more information, choose an article:

Playing an Audio Clip
Playing an Animation, Video Clip or the Demo



Playing an Audio Clip
Some articles in Bookshelf contain an audio icon: 
When you see this icon, you can click it to hear music or sound. To stop the recording before 
it is done, click the audio icon again.
In some articles in the quotation book, you will see a simple multimedia controller. You can 
use the controller to play an audio clip of the person speaking his or her quotation.
To play an audio clip:

To start the audio clip, click the arrow button on the right.
To pause the audio clip, click the arrow button again. Click it one more time to restart 

the audio clip.
To stop the audio clip, click the square button.
To keep track of the progress of the audio clip, watch the slider glide down the slider 

bar. 
See Also
Choosing Hot Text and Graphics
Playing an Animation, Video Clip, or the Demo
Copying a Pronunciation



Playing an Animation, Video Clip, or the Demo
You can find animations in the Bookshelf encyclopedia. There are video clips in the 
encyclopedia and the chronology. You can find the Bookshelf Demo on the Help menu. You 
can play animations, video clips, or the demo on a simple multimedia controller. It is easy to 
use.
To play an animation, a video clip, or the demo:

To start the animation, video, or demo, click the arrow button on the right.
To pause the animation or demo, click the arrow button again. Click it one more time 

to restart the animation.
To stop the animation, video, or demo click the square button.
To keep track of the progress of the animation, video, or demo watch the slider glide 

along the slider bar. 
To keep track of sections of a narrated animation, watch as the slider goes past the 

tick marks on the controller. Each tick mark indicates a section.
On narrated animations you can use the Section-menu button to the left of the slider. The 
Section menu lets you jump to a specific section of the animation. First, point to the Section-
menu button and hold down the left mouse button. This displays a list of the section titles. 
Then drag the highlight to the section you want to view and release the mouse button. The 
player jumps to that section and begins playing it immediately. (You can also drag the slider 
to a tick mark on the controller to go to a section.) 
The Section-menu button is dimmed if there are no sections.
See Also
Choosing Hot Text and Graphics
Playing an Audio Clip



Copying and Printing from a Book
You can copy or print text from any article in Bookshelf. You can also copy some Bookshelf 
pictures for use in your own documents. Like other reference materials, Bookshelf is 
protected by copyright laws. Be sure to note your source when you reuse information from 
the books in Bookshelf.
For more information, choose an article:
Copying Information

Infinite Links: Using the Right-Click Shortcut Menu
Copying Text
Copying a Picture
Copying an Audio Clip or Pronunciation
Copying an Article to Word
Copy Dialog Box Description
Copy to Word Dialog Box Description

Printing Information
Printing an Article
Changing Printers and Printer Options



Copying Text
You can copy text from a Bookshelf article onto the Clipboard. From the Clipboard, you can 
paste the text into another application or document. You can also copy text from Bookshelf 
into the Bookshelf Note feature.
 There's a really fast way to copy a word. Simply right-click on the word and then click 

the Copy command on the menu that appears.
To copy Bookshelf text onto the Clipboard:
1. Go to the article that contains the text you want to copy.
2.    Select the text you want to copy. If you want to copy the whole article, you don't need to 

select it.
3. From the Edit menu, choose Copy, or press CTRL + C. (Or, click the Copy button on the 

Article Window, click Copy Selected Text or Copy All Text, and then click OK.)
The text is copied onto the Clipboard.

To paste the Clipboard contents into another application:
Choose the Paste command from the application's Edit menu, or press CTRL + V.

 To copy and paste text into Microsoft Word in a single process, click Copy to Word on the 
Edit menu. Or, select the text, and right-click to open the infinite links menu. Then click Copy
to Word.
See Also
Infinite Links: Using the Right-Click Shortcut Menu
Copying an Article to Word
Selecting and Editing in Text Boxes with Keys
Copy Dialog Box Description
Copying and Pasting into a Note
Using the Buttons on the Article Window
Copying a Picture



Copying a Picture
You can use the Copy Picture command on the Edit menu to copy a picture from a Bookshelf 
article onto the Clipboard. From the Clipboard, you can paste the picture into another 
application or document. Some pictures cannot be copied: for example, topographic maps in
the atlas and animation frames in the encyclopedia.
To copy a Bookshelf picture onto the Clipboard:
1. Go to the article that contains the picture you want to copy.
2. From the Edit menu, choose Copy Picture. Or click the Copy button on the Article Window, 

click Copy Picture, and then click OK.
If a picture cannot be copied, the Copy Picture command is dimmed.

To paste the picture into another application:
Choose the Paste command from the application's Edit menu.

See Also
Copying Text
Copy Dialog Box Description
Using the Buttons on the Article Window



Copying an Audio Clip or Pronunciation
You can use the Copy Audio command on the Edit menu to copy an audio clip, such as a 
pronunciation, from a Bookshelf article onto the Clipboard. From the Clipboard, you can 
paste the audio clip into another application.
To copy a Bookshelf audio clip onto the Clipboard:
1. Go to the article that contains the audio icon for the sound or pronunciation you want to 

copy.
2. From the Edit menu, choose Copy Pronunciation. Or, click the Copy button on the Article 

Window, click Copy Pronunciation, and then click OK.
If a sound cannot be copied, the Copy Pronunciation command (or the Copy Pronunciation
option) is dimmed.

To paste the sound or pronunciation into another application:
Choose the Paste Special command from the application's Edit menu.

See Also
Selecting and Editing in Text Boxes with Keys
Copying Text
Using the Buttons on the Article Window



 Copying an Article to Word
Now you can copy all or part of the text of a Bookshelf article to Microsoft Word for Windows 
in a single process. When you have installed both Bookshelf and Word, Bookshelf can copy 
your text and paste it into Word right where you want it. Just choose the Copy to Word 
command from the Edit menu. If you are currently running Word, all the open Word articles 
will be listed for you. Bookshelf will paste the text into any Word Document you select. If 
Word is not open, Bookshelf will open it for you and paste text from an article into a new 
document.
To copy text directly into Word:
1. Go to the article with the text you want to copy. If you want to copy only a portion of the 

article, highlight that text.
2. From the Edit menu, choose Copy to Word. Or press CTRL + W.

Alternatively, select the text, and then right-click to display the infinite links menu. Then 
click Copy to Word.

3. Make a selection from the Copy To list:
 New document. Click this if Word is not currently open, or if Word is open and you want to 

create a new document.
 Current location. Click this if you want to copy text into an open Word document right 

where you left the insertion point.
 End of [document name]. Click this if you want to add your text to the end of the named 

document.
4. Click Copy to copy and paste the text and close the box. Click Cancel if you decide not to 

copy. Click Help for information on the dialog box.
See Also
Selecting and Editing in Text Boxes with Keys
Using the Buttons on the Article Window



Printing an Article
You can print the text of any Bookshelf article, although the text may look different in print 
than the way it appears on your screen. When you print, Windows may use a different font. 
In addition, special characters may be printed differently or may not print at all. Most 
Bookshelf pictures cannot be printed.
To print the text in an article:
1. Go to the article that contains the text you want to print. If you want to print only a part of

the article, select that text.
2. From the File menu, choose Print Article.
3. If you care to, select options before you print an article.

Depending on the printer you are using, you can select options such as Print Quality and 
Number of Copies (and Collate Copies). Click the Setup button to change your printer 
settings.

4. Click the OK button. This starts your print job and closes the dialog box. (Click Cancel if 
you decide not to Print.)

See Also
Using the Buttons on the Article Window
Changing Printers and Printer Options



Changing Printers and Printer Options
Bookshelf prints articles on the default printer for Windows. If you have installed more than 
one printer in Windows, you can make any of your installed printers the default printer. You 
can also change the default printer options.
To change printers and printer options:
1. From the File menu, choose Print Article.
2. In the Print dialog box, click the Setup button.
3. Under Specific Printer, select the printer that you want to change to.

If the printer is not in the list box, use the Control-menu to Switch To the Windows 
Program Manager, double-click the Control Panel icon, select Printers, and then activate 
the printer you want to use. Then switch back to Bookshelf. (For more information on 
switching between programs, see Task List Dialog Box Description.

4. Click the Options button in the Print Setup box if you need to change the default printer 
options.
The options available depend on the type of printer you have selected.

5. Select the options you want, and then click OK to return to the Print Setup box.
6. Click OK again to close the Print Setup box.
For more information on setting up printers, see your Windows documentation.
See Also
Using the Buttons on the Article Window
Print Setup Box Description
Printing an Article



Adding a Note To an Article
You can add your own notes to any Bookshelf article. When you add a note to an article, 
Bookshelf reminds you by displaying a Note icon to the right of the article title.
You can also use the Note feature as a bookmark, so you can keep track of interesting 
articles. When you type a note, you add it to a list that you can see any time by choosing the
Note command.
To add a note to the current Bookshelf article you have open:
1. From the Edit menu, choose Note.
2. Click the Add Current Article button to put your note on the Articles list, at the left.
3. In the Note text box, at the right, type your note.

If you make a mistake, press the BACKSPACE key to erase any unwanted characters, and 
then continue typing. Text wraps automatically, but you can end a line before it wraps by 
pressing ENTER.

4. Click the OK button to add your note.
Notice that the Note icon appears at the upper right of the article.

 You can click the Note icon to open the Note dialog box and reread your note.
To go back and read your note:
1. From the Edit menu, choose Note.
2. In the Note box, click the name of the article that has the note you want to read.
3. Click the Cancel button when you have finished reading.
 You can use the list in your Note box to jump from article to article. 

To remove a note:
1. From the Edit menu, choose Note.
2. In the Note box, click the name of the article you want to delete.
3. Click Delete, and then click OK.
See Also
Copying and Pasting into a Note
Selecting and Editing in Text Boxes with Keys
Note Dialog Box Description



Copying and Pasting into a Note
You can copy selected text from an article or from another note and paste that text into a 
Note box for another article. Copying and pasting notes is a powerful way to collect 
information in one place. For example, you might copy a small amount of text from the 
"Lincoln" article in the encyclopedia, open a Note dialog box at "Lincoln, Abraham" in the 
dictionary, and then paste the text from the encyclopedia into the Note dialog box in the 
dictionary.
To copy article text onto the Clipboard:
1. Go to the article that contains the text you want to copy.
2. Highlight the text you want to copy.
3. From the Edit menu, choose Copy or press CTRL + C.
To copy a note onto the Clipboard:
1. From the Edit menu, choose Note.
2. In the Note dialog box, click the name of the article that has the note you want to copy.
3. Highlight the note.

Press CTRL + C. This copies the note onto the Clipboard.
4. Click the Cancel button to close the Note dialog box.
To paste text into a note:
1. From the Edit menu, choose Note.
2. In the Note box, click the name of the article that has the note you want to paste the text 

into.
3. Click an insertion point in the text box at the place where you want to add the text.
4. Press CTRL + V. 

This copies your text into the Note dialog box.
5. Click the Cancel button to close the Note dialog box.
See Also
Adding a Note to an Article
Copying Text
Selecting and Editing in Text Boxes with Keys
Copying and Pasting with Keys
Note Dialog Box Description



Bookshelf Tips and Tricks
Here are a few tips and tricks for enjoying "the new way to look it up" in Bookshelf    '94. We 
hope you'll use these tips as springboards for your own discoveries. 
 To learn more about the features discussed here, look them up in Help Contents, or use the

Search button in Help. Words in color are hot; you can click them to pop up a definition.
If you're a new user
Remember, you can pop up names of the books and buttons. It's a good way to get 
acquainted with Bookshelf. Glide the mouse pointer slowly over the icons of books in the 
Book Bar to see their names. When you're using the Tabbed Lists, glide the mouse pointer 
slowly over the icons in the lists to see the book names. If you see a button without a label, 
glide the mouse pointer over it to see its name.
Take another look at the Bookshelf Demo that you watched the first time Bookshelf was 
started. Just choose the Bookshelf Demo command from the Help menu, and refresh your 
knowledge of the new features in Bookshelf.
Use QuickShelf to bring Bookshelf power to your other applications
When you use the QuickShelf Toolbar, it's as if Bookshelf is built right into your other 
applications. Here's a sampling of uses you can make of QuickShelf from other applications:
 If you're reading a document and don't know what a word means, just select the word and 

click the Dictionary Contents button. Bookshelf    brings you the definition. Try selecting a 
word and clicking the Thesaurus Contents button, if you want synonyms fast.
 If you are writing about a place and you're not quite sure where it's located, click the place 

name, then click the Atlas Contents button to see a Bookshelf atlas map.
 If you're writing about a person and want more information, select the name and use 

QuickShelf. Try Quotations Contents to see if he or she has a quotation you can use. Try 
Almanac Find or Chronology Find to get a list of all the articles in which your person's name 
appears--this way you can find out if there are awards, dates, and events that are significant
in that person's life.
 Maximize your screen and see how the QuickShelf Toolbar fits on the title bar.

Add books to QuickShelf
It's easy to add the books you use the most to QuickShelf. Click the down arrow at the right 
of QuickShelf. Choose Customize on the menu, and then click the Toolbar tab. Click to place 
an X next to any Bookshelf book you want to add. You can choose to add either the Contents
or the Find feature (or both) for any book. When you are finished, click OK. Look at the 
QuickShelf Toolbar to see your additions. Glide the mouse pointer over the books to see their
names. 
    After you have opened Bookshelf using QuickShelf, you can minimize Bookshelf instead of

closing it. This way, when you use QuickShelf again, youll get your information even faster.
Practice for word games
Bookshelf can be especially fun for people who enjoy word games, such as crossword 
puzzles. Use Bookshelf 's Find feature to sharpen your skills at discovering new and unusual 
letter variations in words. For example, say you have a five-letter word that begins with a "c"
and ends with a "b" that you just cannot figure out. Open the dictionary and in the Find text 
box, type "c???b". Among your search results, you will see these: climb, crumb, cubeb, carib,
carob, caleb, cribb, clomb, chimb, and celeb. (Using this search technique takes somewhat 
longer than a normal search in Bookshelf.)
Check out the lay of the land with the Topography maps
As you are using the Atlas, be sure to click the colorful Topography Map button to the right of
the article title. You will see this button when a topographic map is available. Use it to get 
another perspective on the region.
Use Bookshelf as a "reverse dictionary"
You can use the Bookshelf dictionary as a reverse dictionary for those times when you know 
what you want to say but just can't think of the word. Use Bookshelf's Find feature and 



simply type in the key concepts relating to the word you want to find. For example, say you 
want to find a word to describe a friend who tends to use long words. Simply type long words
(use quotation marks) in Bookshelf's Dictionary Find and you will find "sesquipedalian" and 
"mouthful" -- two words that apply to people who use long words.
Find out about this day in history
Do you want to know what happened on a particular day in history? Use the Bookshelf All 
Books Find to have fun learning about important and unusual events in world history. In the 
Find text box, type the month and day in quotation marks. For example, to find out what 
happened on July 5th, simply type "July 5" (using quotation marks). You will come up with a 
lengthy list of events that includes Algeria's gaining its independence on that date in 1954 
and the explosion of a supernova in the Taurus constellation on that date in 1054 that was 
visible by daylight for 23 days.
Double-click for fast definitions
When you're reading an article in Bookshelf, and you are unsure of the meaning of a word, 
you can double-click the word to see its definition from the Bookshelf dictionary. When you 
have finished reading the definition, just click the close box in the upper-left corner to close 
the definition box and resume reading the article. 
 Click the audio icon in the definition box to hear the word pronounced.

Right-click your way to information fast
When you're reading a Bookshelf article and you want more information on the subject in a 
hurry, you can right-click a word to search through any book in Bookshelf. Say you are 
reading about Niagara Falls in the encyclopedia. You wonder how Niagara Falls compares to 
other waterfalls in the world. Use the infinite links menu: Right-click the word waterfall in the
article, and then click Almanac. The almanac opens with a list of the world's famous 
waterfalls and their elevations. Go back to the encyclopedia article and right-click waterfall 
again, and this time search in the quotation book to see if there are any memorable 
quotations on the subject. You will turn up a quotation from the prolific Oscar Wilde. Right-
click waterfall again and search the thesaurus for synonyms to make your writing more lively
and to enlarge your search possibilities.
Increase the scope of your discoveries with the Find feature
The Table of Contents is great for locating an article on a specific subject, but if you want to 
throw your net really wide, use the Find feature. Say, for example, you have a paper due on 
capital punishment. You can look up "capital punishment" in the encyclopedia and see a 
good article and some See Also cross-references, but dont stop there. Try a Find on the word 
"beheaded," and you will come up with a list of articles that mention famous beheadings. If 
youre looking for a historical perspective on capital punishment, open the Chronology Find 
Tabbed List and try a Find on "excuted." Youll generate a list of executions that goes back 
thousands of years. Use words and phrases from the articles you read to come up with new 
ideas for using Find.
Browse through a treasure-trove of related information in the Almanac
When you open an article in the almanac, you have just grazed the tip of the iceberg of 
information. Use the >Page and <Page buttons to explore related information in the same 
subject area. For example, if you look up Academy Awards, youll start with awards for 1927-
28. Use >Page to see the awards for subsequent years.
Broaden your horizons using the Atlas windows
Bookshelf makes it easy for you to see the atlas maps. If a map is too large to fit on the 
screen you will see horizontal or vertical scroll bars you can use to see all the parts of the 
map. To make more room on the screen for a map, you can close the Tabbed List at the left 
of the screen. (Click any tab to reopen the Tabbed List Area.) 
Explore the Chronology
If you like the Bookshelf almanac, youll really enjoy the chronology. Try typing your birthday 
year in the Chronology Table of Contents to see articles on significant events in that year on 



subjects from politics, literature, and medicine, to everyday life, food and drink, and sports. 
Try using the Find tab to do a full-text search on a famous person. You will get a list of 
articles of years in which they made a contribution.
Create a custom list of Bookshelf articles
Use Bookshelf's Note feature (it's on the Edit menu) to make your personal list of important 
articles. Cull articles from all the books in Bookshelf, type in your comments on them, and 
add them to your Note list. For example, if you want to gather information on international 
trade you can look up encyclopedia articles on business, law, and economics; look in the 
atlas for maps of countries that could be potential trading partners; look in the chronology 
for important historical events by year; look in the almanac for lists of important awards and 
economic trends; and look in the quotation book for great quotes on business (like, "Making 
money is art. . . " from Andy Warhol).
Use your own path to find your way in Bookshelf
Sometimes, when you jump from article to article, taking advantage of Bookshelf's many 
pathways into its information, you may not remember where you found an article. Bookshelf 
provides several ways to jog your memory. You can open a list of up to 40 articles that youve
just viewed by clicking the Back Tab. Use this list to go back to articles that you want to 
reread. You can also use the Back button on the bottom of the Article Window. This takes you
back to articles youve already read, one article at a time.
Experiment with Bookshelf color and sound
Personalize the effect of    Bookshelf colors and sounds. You can double-click the Color icon in
the Windows Control Panel and then reset the text and window colors in Bookshelf. In 
addition, Bookshelf has an Options dialog box (Click Options on the Tools menu) where you 
can change the color of hot text. Also, you can use this dialog box to turn off the Bookshelf 
sounds, the Tooltip popups, or the dark texture behind the Bookshelf menu bar.
Do you love finding interesting words?
If someone tells you your shoes look like "winkle pickers," do you know if you've been 
complimented? Investigate each word and see what you think. When you encounter a new 
word, look it up in the dictionary. When you are reading the dictionary definition, right-click 
on the new word and use the infinite links menu to do a full-text search on the word in the 
thesaurus. Try another right-click on the word and look for it in the encyclopedia. If it is a 
place, right-click again and look in the atlas. Infinite links can help you find more information
fast.
Close boxes and windows fast
Just double-click the Control-menu box in the upper left corner. If the box in the corner does 
not contain a bar, a single click will close it fast. This works in Help, too.



Frequently Asked Questions
Sometimes users have questions about the way Bookshelf works. Usually, these questions 
can be answered by using the other portions of Bookshelf Help. However, some questions 
are more technical. What follows are a number of troubleshooting situations: A circumstance
is described and solutions are suggested. Please read these situations over and see if they 
can help you out.

TROUBLESHOOTING: AUDIO PROBLEMS

Sound Does Not Play at All

1. Check the volume.
2. If the volume is turned up and you still hear no sounds, something may be wrong with 

your sound board installation. Check to see that the sound board drivers and necessary 
Windows drivers are installed correctly and reinstall if necessary.

To check the installed drivers, open the Windows Control Panel and click on the Drivers 
icon.

Windows drivers necessary for sounds include:

Timer
MIDI Mapper
[MCI] Sound
[MCI] MIDI Sequencer

If any of these drivers are missing add them by clicking the Add button.

3. If the software is installed correctly, the sound board may need to be pressed more 
securely into its slot or have a jumper setting changed on the sound board.

4. If you have both a sound board and special software that bypasses the sound board to 
play sounds through the PC speaker, we suggest you remove or disable the special 
software (the PC speaker driver). Bookshelf requires an MPC-compatible sound board to 
be installed and is not meant to run with the PC internal speaker or any combination of 
that speaker and special software.

Sound is Distorted or Fuzzy

Sound distortion is often caused by sending a higher volume or amplitude of sound to the 
speakers than they are able to handle, or by turning the volume control on your sound board
too high (distortion from the amplifier on the sound board). Sometimes speakers that are not
of high quality will distort at a lower volume than better speakers will (compare a clock radio
speaker to a big stereo system; the stereo speakers can play much louder with no 
distortion). For example, if the volume for your sound board or WAVE file output is set to 
near its maximum it will produce distortion just like a radio that is turned up too loud. To 
learn how to change your sound board settings check the manuals that came with your 
sound board. This is normally done with either a volume dial on the back of your sound 
board (in the rear of your computer where the speakers plug in) or with a program that is 
often called a mixer, that is usually installed in the Windows Control Panel of the Main 
program group. Some sound boards use both types of controls and they must both be 
adjusted.

Sound plays, but audio breaks up



If audio breaks up or skips periodically it is usually an indication that the CD-ROM drive does 
not fully meet the MPC (Multimedia PC) specification for the Data Transfer Rate. The MPC 
specification states that the CD-ROM drive needs to be capable of transferring data at a rate 
of 150 KB per second while utilizing 40% or less of the CPU.    You can continue to use your 
CD-ROM drive to run Bookshelf, but will continue to experience this choppiness in audio and 
animation clips.

Sounds are cut off

Your computer can only play one sound at a time therefore other sound producing programs 
could interrupt the sounds in Bookshelf. Some sound producing programs may take over the 
audio capability and prevent other Windows programs from being able to make sounds. If 
you suspect you have such a program do not run it at the same time as Bookshelf.

MIDI fails to play

1. Check to see that you can play MIDI from MS-DOS. Most sound cards come with a test 
utility or an MS-DOS program for playing MIDI or testing the card configuration. If MIDI 
does not work with these then the MIDI will not work in Windows either.

2. Verify Port and IRQ settings by looking at the sound card and comparing the way it is set 
up to the way that the sound board software thinks it is set up. The sound board manual 
should explain how to check the sound board settings.

3. Make sure the sound card does not conflict with other hardware. This is done by 
comparing the settings of the sound board with the setups of other cards in your 
computer. It is important that no two cards try to use the same port or IRQ. This is a 
common source of problems when you are getting no sound at all.

4. Make sure a MIDI driver is installed and properly configured in the Drivers section of the 
Windows Control Panel.

5. Make sure the MIDI Mapper is properly configured in the Windows Control Panel.

TROUBLESHOOTING: MIDI WITH MEDIA PLAYER

Media Player is a program that can play MIDI files. It is normally located in the Accessories 
group in the Program Manager. It allows you to check the MIDI installation in a simple way. 
After using the File Open command to load a .MID file into Media Player (there should be 
some in the Windows directory) please click the Play button. The following message may 
occur:

The current MIDI Mapper setup refers to a MIDI device that is not installed on the system. 
Use MIDI Mapper to edit the setup.

If this message appears, it means that your MIDI Mapper is not configured properly. The first 
thing to do in this case is to check if your MIDI Mapper configuration was changed:
1. Look for a file called MIDIMAP.OLD in your \windows\system directory. If this file exists, it 

means that your original MIDI Mapper configuration file was replaced
2. If you see a MIDIMAP.OLD, then rename MIDIMAP.CFG to MIDIMAP.BAK.
3. Now rename MIDIMAP.OLD to MIDIMAP.CFG.
4. Try playing a MIDI file in Media Player.

If this procedure fails or is inapplicable, run Control Panel (usually in the Main group of the 
Windows Program Manager) and check the setup in the MIDI Mapper.



For example, if the Ad Lib driver is installed in the Drivers part of the Control Panel, the MIDI 
Mapper should be set for Ad Lib. If a different MIDI device is installed, choose an appropriate 
setup for the device. For more information on setting up the MIDI device drivers look in the 
manuals that came with your sound board.

Setting the MIDI Mapper

To set the MIDI Mapper to use the Ad Lib setup:

1. Run Control Panel.
2. Run MIDI Mapper.
3. Press ALT+S to show setups.
4. Press ALT+A to move to the name field for setups.
5. Use the UP ARROW and DOWN ARROW keys to set the name field to Ad Lib, and the description

below the name field to "Base-level setup."
6. Close the MIDI Mapper to accept this setup.

TROUBLESHOOTING TIPS: VIDEO DISPLAY CARDS AND DISPLAY PROBLEMS

In some situations, Bookshelf may encounter video display problems when using high 
resolution video drivers from various video card manufacturers. This problem can often be 
fixed by obtaining updated drivers from your video card manufacturer. Make sure the video 
drivers you are using were designed to be compatible with Microsoft Windows version 3.1.

An alternative to obtaining a new or updated display driver is to change your video mode to 
a standard video mode such as 640 x 480 resolution, with as many colors as your video card
can support at that resolution. To use Bookshelf while waiting for an updated video driver 
from your video card manufacturer, you can use the standard VGA driver that comes with 
Windows. This display mode is only 16 colors and some images may not look as well as they 
would in 256 colors. Also, image display takes slightly longer when running in 16 color mode.
For instructions on installing that, please see Help within Windows Setup in the Main 
program group in the Windows Program Manager.

Obtaining Updated Drivers from Your Video Card Manufacturer

Contact the manufacturer of    your video card for updated Windows display drivers. Their 
phone number should be in the manuals that came with your video card or personal 
computer. Another option for obtaining updated drivers is the Microsoft Download service 
(MSDL), an electronic bulletin board that can be accessed via a modem at (206) 936-MSDL 
(6735).

Drivers provided on the MSDL are compressed with the PKWare utilities, and are in the form 
of executable files (.EXE extension). It is best to download the file or files you need into an 
empty directory to your hard disk, or a blank formatted floppy. To decompress these drivers 
after downloading them, type their filename.

IMPROVING PERFORMANCE

Microsoft Bookshelf uses the random-access memory (RAM) of your computer to display 
pictures and play animations and sound. If Bookshelf runs slowly or you see out-of-memory 
errors, Bookshelf may not have enough memory. Below are some ideas to make Bookshelf 



run faster.

1. Close all applications you are not using.
2. Set up a permanent Windows swap file. Windows usually creates a Temporary swap file by

default when running in 386 Enhanced Mode. (To determine if Windows is running in 386 
Enhanced Mode look in the Help About menu of Program Manager )    However if your disk 
is full or fragmented, this temporary file can become unavailable. This can affect 
performance, since Windows works best when it has allocated hard disk space to use at 
any time for swapping a file in or out of the memory of your computer. It is therefore best 
to set up a permanent swap file, and to make the size of the permanent swap file at least 
2048K. Note that you will get better performance if the permanent swap file is set to 
3072K or larger. To set up a permanent Windows swap file on your hard disk, open 
Windows Control Panel (usually in the Main program group of Program Manager), and click
the 386 Enhanced icon. Then click the Virtual Memory button to see whether your current 
swap file is Temporary or Permanent.

3. Defragment or optimize your hard disk by running a defragmentation program. If you are 
Using MS-DOS 6.0 or higher use the DEFRAG utility included with MS-DOS. Other popular 
utilities which provide defragmentation are PC Tools, Norton Utilities, and Mace Utilities.

4. Add more RAM to your computer. You can determine how much memory is available by 
starting MS-DOS, typing mem and pressing ENTER. This starts a program that will tell you 
how much memory you have. You need at least four megabytes (sometimes listed as 
4096 kilobytes or KB) of RAM, and at least two megabytes in the Windows swap file of 
your hard disk to run Bookshelf.

5. For complete details on optimizing the performance of Windows consult your Windows 
manual.

PRINTING

Printers differ in their abilities to use fonts, graphics, spacing, alignment, and character 
formats. The appearance of your printed document can vary greatly from printer to printer. 
The way your document looks depends on which formats you assign and which formats your 
printer can print. If you encounter printing problems from Bookshelf such as no printout, low 
print quality or erratic text being printed,    there are several ways to troubleshoot or correct 
the problem. This section provides basic information about printing with Microsoft Bookshelf. 
When you follow the steps to find and solve a problem, try to print after each step before 
you try the next one. If the problem is not solved, go on to the next step.

 If the printer displays a message or an error indicator, see your printer manual for 
information about how to correct the problem.

The Printer Does Not Print at All

When a printer will not print, the cause is often a simple mechanical problem; that is, the 
printer may be offline, or not connected to the computer.
If you cannot print with Bookshelf, but have printed from other programs, check the printer 
settings by using the Control Panel or the Print Setup command on the File menu in 
Bookshelf.
Try the following, if you cannot print:
    Make sure that the printer is plugged in and turned on.
    Make sure that the printer is connected to the computer and is on line, as shown on the 

printers control panel.
    Make sure that the correct printer is selected and the printer settings are correct. Choose 



Print from the File menu, and then click the Setup button, to see if the correct printer is 
selected. If the printer you are using is not listed, use the Windows Control Panel to install 
your printer. For additional information about installing a printer, see your Windows 
documentation.
    If you have a serial printer, check the settings for your serial port by using the Ports 

command on the Settings menu in the Control Panel to make sure your serial port settings 
are properly selected.
    Look at the Printers dialog box in the Control Panel to make sure the correct port is 

specified for your printer.
    Make sure that you have the correct cable for your printer and that the printer cable is 

properly connected.
Output is Garbled

1. Try copying the text you wish to print to a word processor such as Microsoft Word for 
Windows and print from that program. Printing from a word-processing program may, in 
some cases, produce better quality than printing directly from Bookshelf.

2. Check the printer in the Print Setup dialog box (choose Print from the File menu, and then 
click Setup). If the wrong printer or the wrong font cartridge is selected, the printer may 
insert stray characters at the beginning of lines or behave in other unpredictable ways.

3. If you are using a serial printer, choose the Ports command in the Windows Control Panel 
and check the settings in the Settings dialog box to make sure the baud rate and printer 
parameters are set according to manufacturer's specifications. Decreasing the baud rate 
may cause the printer to print correctly.

4. Reset the printer; turn it off and on again.
5. Try reinstalling the printer driver.

Only Part of a Page Is Printed

Laser printers cannot print all the way to the edge of the page (sometimes called the 
unprintable region), so, if you have a laser printer,    remember to include the figure (usually 
0.25 or 0.5 inch) in your calculations for page size.
If you are printing to a serial port and it prints the document but loses blocks of text, you 
may have a handshake problem. 
To check for a Handshake problem investigate the following: 
1. Check the baud rate and other parameters you selected with the Ports command in the 

Control Panel to make sure they match the manufacturers specifications.
2. If you are still losing text, change to a lower baud rate than the one you are using, and try

to print again.
3. Check all the manual switches on your printer against the settings described in your 

printer manual to make sure the switch settings are correct.
4. Check to make sure you have the proper cable for your printer.

Your printer may not have enough memory to print the entire page. Try printing at a lower 
resolution.

Other Printing Tips

Many printers emulate industry-standard printers such as the Epson LQ, IBM Proprinter,    or 
Hewlett-Packard LaserJet series. Consult your printer manual to see if your printer supports 
an emulation. If it does, install the driver for the printer it emulates in the Control Panel.

Check with your printer dealer or manufacturer. If you have purchased a printer model that 



has not been on the market for very long, your dealer or manufacturer may have a Windows 
printer driver for your printer.

To use the TTY.DRV printer driver, select Generic/Text Only from the List of Printers in the 
Setup program or choose Printers from the Control Panel. Install this printer as you would 
any other printer. The TTY.DRV printer driver can direct your printer to print underlines, strike
through, bold, or to substitute underlining for italic and double underlines. It cannot print 
graphics. For information on installing a printer, see your Windows documentation.

TROUBLESHOOTING TIPS:    CD-ROM DRIVES

    Do not remove the Bookshelf compact disc from your CD-ROM drive while running 
Bookshelf.

If Bookshelf cannot find the data files it needs to run; you will see an error message 
prompting you to correct the problem. To find the source of the problem, do the following:

1. Make sure the Bookshelf compact disc is correctly inserted into the CD-ROM drive.
2. Make sure that the Bookshelf program is looking for the compact disc on the correct drive.

Check that the command line for Bookshelf has the same drive letter as your CD-ROM 
drive. This can be checked in the Windows Program Manager; highlight the Bookshelf 
icon, select the File menu and then Properties. You can then use the Windows File 
Manager to determine which drive letter is assigned to the CD-ROM drive. The Select 
Drive command in the Disk menu will say CD-ROM next to the drive letter.

3. If you have an external CD-ROM drive make sure that the drive is connected to your 
computer, plugged in, turned on and functioning in MS-DOS. This can be done by viewing 
a directory of the drive at an MS-DOS prompt. To do this, change to the CD-ROM drive at 
an MS-DOS prompt, type DIR and press ENTER.

TROUBLESHOOTING: GENERAL PROTECTION FAULTS

A General Protection Fault is a memory error--typically caused by a driver and/or a 
application writing to a memory address that it is not allocated. If you receive a General 
Protection Fault, follow these steps:

1. Try running Windows in Standard Mode. If Standard Mode Windows works, try starting 
Windows in the enhanced mode with the following command:

WIN /D:XV

2. If this solves the problem, make the following modifications to your SYSTEM.INI file in 
the [386Enh] section:

EMMEXCLUDE=A000-EFFF
 VIRTUALHDIRQ=OFF

3. Check the General Protection Fault message box: It should indicate which module has 
affected the application. Disable or replace the indicated module (which is typically a 
driver or an application). If your system seems to generate frequent General Protection 
Faults, contact Microsoft Product Support Services.




